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1 About this document
These original operating instructions contain information regarding the proper use of the CML 700i 
measuring light curtain series. It is included in the delivery contents.

1.1 Used symbols and signal words

Table 1.1: Warning symbols, signal words and symbols

Table 1.2: Operating on the display

1.2 Terms and abbreviations

Table 1.3: Terms and abbreviations

This symbol precedes text messages which must strictly be observed. Failure 
to observe the provided instructions could lead to personal injury or damage to 
equipment.

NOTE
Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

Symbol for tips
Text passages with this symbol provide you with further information.


Symbol for action steps
Text passages with this symbol instruct you to perform actions.

Main Settings
Bold text
Indicates that this field is currently selected and appears highlighted in 
the receiver display.

Digital IOs
Normal text
Indicates that this field is not currently selected (is not highlighted in the 
receiver display).

DTM (Device Type Manager) Software device manager of the sensor

IO Input Output

FB (First Beam) First beam

FIB (First Interrupted Beam) First interrupted beam

FNIB (First Not Interrupted Beam) First not interrupted beam

FDT (Field Device Tool) Software frame for management of device managers (DTM)

LB (Last Beam) Last beam

LIB (Last Interrupted Beam) Last interrupted beam

LNIB (Last Not Interrupted Beam) Last not interrupted beam

TIB (Total Interrupted Beams) Total of interrupted beams

TNIB (Total Not Interrupted Beams) Total of not interrupted beams (TNIB = n - TIB)

n Number of all logical beams of a light curtain; dependent on the 
selected measurement field length and resolution as well as the 
beam mode (parallel- / diagonal- / crossed-beam scanning)
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EDS Electronic Data Sheet (EDS file for CANopen interface)
Description of the device for the control

GSD (Generic Station Description) Device master data file (GSD file for PROFIBUS interface)
Description of the device for the control

IODD IO Device Description (IODD file for IO-Link interface)
Description of the device for the control

GUI (Graphical User Interface) Graphical user interface

RTU Remote Terminal Unit (serial RS 485 Modbus RTU mode)

PLC Programmable Logic Control
(corresponds to Programmable Logic Controller (PLC))

Response time per beam Length of time for the evaluation of a beam

Resolution The minimum size of an object that can be reliably detected. 
With parallel-beam evaluation, the smallest object to be 
detected corresponds to the sum of beam spacing and optic 
diameter.

Delay before start-up Duration between the switching on of the supply voltage and 
the start of operational readiness of the light curtain

Function reserve (sensitivity adjust-
ment)

Ratio of the optical reception power set during the teach event 
and the minimum light quantity required to switch the individual 
beam. This compensates for the light attenuation caused by 
dirt, dust, smoke, humidity and vapor.
High function reserve = low sensitivity
Low function reserve = high sensitivity

Measurement field length Optical detection range between the first and last beam

Beam spacing Center-to-center spacing between two beams

Cycle time Sum of the response times of all beams of a light curtain plus 
the duration of the internal evaluation.
Cycle time =
number of beams x response time per beam + evaluation time
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1 TIB (total of interrupted beams)
2 TNIB (total of not interrupted beams)
3 LIB (Last interrupted beam )
4 LNIB (Last not interrupted beam)
5 FNIB (First not interrupted beam)
6 FIB (First interrupted beam)

Figure 1.1: Definition of terms

1

6

3

2

2

5

4
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2 Safety
This sensor was developed, manufactured and tested in line with the applicable safety standards. It corre-
sponds to the state of the art.

2.1 Intended use
The device is designed as a measuring and object-detecting, configurable, multi-sensor unit.

Areas of application

The measuring light curtain is designed for the measurement and detection of objects for the following 
areas of application in handling and warehousing systems, the packaging industry or a comparable envi-
ronment:

• Height measurement
• Width measurement
• Contour measurement
• Orientation detection

2.2 Foreseeable misuse
Any use other than that defined under “Intended use” or which goes beyond that use is considered 
improper use.

In particular, use of the device is not permitted in the following cases:
• in circuits which are relevant to safety
• for medical purposes

2.3 Competent persons
Connection, mounting, commissioning and adjustment of the device must only be carried out by competent 
persons.

CAUTION
Observe intended use!
 Only operate the device in accordance with its intended use.

The protection of personnel and the device cannot be guaranteed if the device is operated in a manner 
not complying with its intended use.
Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.

 Read the original operating instructions before commissioning the device.
Knowledge of the original operating instructions is an element of proper use. 

NOTICE
Comply with conditions and regulations!
 Observe the locally applicable legal regulations and the rules of the employer's liability insurance asso-

ciation.

NOTICE
Do not modify or otherwise interfere with the device!
 Do not carry out modifications or otherwise interfere with the device.

The device must not be tampered with and must not be changed in any way.
The device must not be opened. There are no user-serviceable parts inside. 
Repairs must only be performed by Leuze electronic GmbH + Co. KG.
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Prerequisites for competent persons:
• They have a suitable technical education.
• They are familiar with the rules and regulations for occupational safety and safety at work.
• They are familiar with the original operating instructions of the device.
• They have been instructed by the responsible person on the mounting and operation of the device.

Certified electricians
Electrical work must be carried out by a certified electrician.
Due to their technical training, knowledge and experience as well as their familiarity with relevant stan-
dards and regulations, certified electricians are able to perform work on electrical systems and indepen-
dently detect possible dangers.
In Germany, certified electricians must fulfill the requirements of accident-prevention regulations DGUV 
(German Social Accident Insurance) provision 3 (e.g. electrician foreman). In other countries, there are 
respective regulations that must be observed.

2.4 Exemption of liability
Leuze electronic GmbH + Co. KG is not liable in the following cases:

• The device is not being used properly.
• Reasonably foreseeable misuse is not taken into account.
• Mounting and electrical connection are not properly performed.
• Changes (e.g., constructional) are made to the device.

2.5 Notices for the safe use of sensors in potentially explosive areas
These notices apply for devices with the following classification:

Table 2.1: Classification of the devices

Installation and Commissioning
 Only have the devices installed and commissioned by certified electricians.

The certified electricians must be knowledgeable of the regulations and the operation of explosion-proof 
equipment.

 Prevent unintended disconnection while under voltage.
Devices with connector must be equipped with a safeguard or a mechanical interlocking guard; see 
table 17.9.
Attach the warning sign “Do not disconnect under voltage” that is supplied with the device to the sensor 
or the mounting bracket so that it is clearly visible.

Device group Device category Equipment protection 
level

Zone

II 3G Gc 2 (gas)

II 3D Dc 22 (dust)

WARNING
Safe use of sensors in potentially explosive areas!
 Check whether the device classification corresponds to the requirements of the application.

A safe operation is only possible if the devices are used properly and for their intended purpose.
The devices are not suited for the protection of persons and may not be used for emergency shutdown 
purposes.
Electrical devices may endanger humans and (where applicable) animal health, and may threaten the 
safety of goods if used incorrectly or under unfavorable conditions in potentially explosive areas.

 Observe the applicable national regulations (e.g., EN 60079-14) for the configuration and installation 
of explosion-proof systems. 
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 Protect the connection cables and connectors from excessive pulling or pushing strain.
 Avoid electrostatic charging.

Integrate metallic parts (e.g., housing, mounting devices) in the potential equalization. 
 Prevent dust deposits from forming on the devices.

Maintenance
Make no changes to explosion-proof devices.

Cyclical maintenance of the device is not necessary.
 Replace defective devices immediately. 
 Only have repairs performed by the manufacturer.
 Clean the lens cover of the device from time to time; see chapter 14 "Care, maintenance and disposal".

Chemical resistance

• The devices demonstrate good resistance against diluted (weak) acids and bases.
• Exposure to organic solvents is possible only under certain circumstances and only for short periods 

of time.
• Test the resistance to chemicals on a case-by-case basis.

Special conditions
 Protect the devices from direct exposure to UV rays.

The devices must be installed in such a way that they are not directly exposed to any UV rays (sunlight).
 Avoid static charging on plastic surfaces. 
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3 Device description

3.1 General information
The light curtains of the CML 700i series are designed as measuring and object-detecting, configurable, 
multi-sensor units. Depending on the configuration and model, the devices are suitable for a variety of 
tasks with various resolutions and can be integrated in different control environments.
The total system of the light curtain consists of a transmitter and a receiver, including the connection and 
interconnection cables.

• Transmitter and receiver are connected to one another via a synchronization cable.
• The integrated control panel with indicators and operational controls for configuring the total system 

is located on the receiver.
• The shared power supply is provided via connection X1 on the receiver.

1 Transmitter
2 Receiver
3 IO Logic with control panel
4 Control (PLC)
5 Synchronization cable
6 Connection cable for supply voltage and measurement data interface

Figure 3.1: Total system in combination with a programmable logic control

3.2 General performance characteristics
The most important performance characteristics of the CML 720i EX series are:

• Operating range up to 7000 mm
• Measurement field length from 130 mm to 2950 mm
• Beam spacings of 5 mm*, 10 mm, 20 mm, 40 mm*

*: Devices with beam spacing of 5 mm and 40 mm can only be ordered upon consultation with 
Leuze electronic.

• Response time 30 µs per beam
• Beam modes: parallel, diagonal, crossed-beam
• Single-beam evaluation (beam-stream)
• Evaluation functions: TIB, TNIB, LIB, LNIB, FIB, FNIB, status of beam areas 1 … 32, status of the 

digital inputs/outputs
• Local control panel with display
• Interfaces to the machine control:

• IO-Link and CANopen interfaces:

X2X3

3

2 41

X1

5 6
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2 digital inputs/outputs (configurable)
• Blanking of unnecessary beams
• Smoothing for interference suppression
• Cascading of multiple devices
• Block evaluation of beam areas
• Position / hole recognition with continuous web material
• Explosion protection

• Zone 22 (dust)
Devices with measurement field length from 130 mm to 2950 mm

• Zone 2 (gas)
Devices with measurement field length from 130 mm to 2550 mm

3.3 Connection technology
The transmitter and receiver feature an M12 connector with the following number of pins:

3.4 Display elements
The display elements show the device status in operation and provide support during commissioning and 
error analysis.

Located on the receiver is a control panel with the following display elements:
• two LEDs
• one OLED display (Organic Light-Emitting Diode), two-line

Located on the transmitter is the following display element:
• one LED

3.4.1 Operation indicators on the receiver control panel
Two function indicator LEDs are located on the receiver control panel.

1 LED1, green
2 LED2, yellow

Figure 3.2: LED indicators on the receiver

Device type Designation on device Connector/socket

Receiver X1  M12 connector, 8-pin

Receiver X2  M12 socket, 5-pin

Transmitter X3  M12 connector, 5-pin

1

2
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Table 3.1: Meaning of the LEDs on the receiver

3.4.2 Display on the receiver control panel
Located on the receiver is an OLED display which serves as a function indicator.

Figure 3.3: OLED display on the receiver

The type of display on the OLED display is different for the following operating modes:
• Alignment mode
• Process mode

Display indicators in alignment mode
In alignment mode, the OLED display shows the received signal level of the first active logical beam (FB) 
and of the last active logical beam (LB) via two bar graph indicators.

1 Evenly aligned light curtain
2 No reception signal from first beam (FB); good reception signal from last beam (LB)
3 Marker for the minimum signal level which is to be achieved

Figure 3.4: OLED display on the receiver in alignment mode

Display indicators in process mode
In process mode, the upper line shows the number of interrupted beams (TIB) and the lower line shows 
the logic state of the digital outputs.The value to be displayed is configurable.

LED Color State Description

1 Green ON (continuous 
light)

Light curtain ready (normal mode)

Flashing see chapter 13.2

OFF Sensor not ready

2 Yellow ON (continuous 
light)

All active beams are free - with function reserve

Flashing see chapter 13.2

OFF At least one beam interrupted (object detected)

1 2 3



Device description

Leuze electronic GmbH + Co. KG CML 720i Ex 16

1 Total of interrupted beams
2 Logic state at pin 2 (0 = not active, 1 = active)
3 Logic state at pin 5 (0 = not active, 1 = active)
4 Logic state at pin 6 (0 = not active, 1 = active)
5 Logic state at pin 7 (0 = not active, 1 = active)

Figure 3.5: OLED display on the receiver in process mode

3.4.3 Operating indicators on the transmitter
Located on the transmitter is an LED which serves as a function indicator.

Table 3.2: Meaning of the LED on the transmitter

3.5 Operating elements on the receiver control panel
Located on the receiver below the OLED display is a membrane keyboard with two function buttons for 
entering various functions.

Figure 3.6: Function buttons on the receiver

3.6 Menu structure of the receiver control panel
The following summary shows the structure of all menu items. In a given device model, only the actually 
available menu items are present for entering values or for selecting settings.

If the control panel is not used for several minutes, the display darkens and switches off. Press                
a function button to again make the display visible. Settings for visibility, display duration, etc.              
can be changed via the Display menu.

1

2 3 4 5

LED Color State Description

1 Green ON
(continuous light or 
flashing in sync with 
the measurement)

Light curtain operates continuously with maximum measure-
ment frequency

OFF No communication with the receiver
Light curtain waits for external trigger signal
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Menu level 0

Menu “Main Settings”

Menu “Digital IOs”

Level 0

Main Settings

Digital IOs

Analog Output

Display

Information

Exit

Level 1 Level 2 Description 

Commands Teach Reset Factory settings Exit

Operation settings Filter depth (enter value)
min = 1
max = 255

Beam mode Parallel Diagonal Crossed-beam

Function reserve High Medium Low

Blanking Teach Not active
Active

Power-Up teach Not active
Active

Smoothing (enter value)
min = 1
max = 255

Inv. Smoothing (enter value)
min = 1
max = 255

IO-Link Bit Rate COM3: 230.4 kbit/s COM2: 38.4 kbit/s

PD Length 2 bytes 8 bytes 32 bytes

Data Storage Deactivated Activated

CANopen Node ID (enter value)
min = 1
max = 127

Bit Rate 1000 kbit/s 500 kbit/s 250 kbit/s 125 kbit/s

Level 1 Level 2 Description 

IO Logic Positive PNP  Negative NPN

IO Pin 2
IO Pin 5
IO Pin 6
IO Pin 7

IO function Trigger In Teach In Area Out Warn Out Trigger Out

Inversion Normal Inverted

Teach height Execute Exit

Area logic AND OR

Start beam (enter value)
min = 1
max = 1774

End beam (enter value)
min = 1
max = 1774
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Menu “Display”

Menu “Information”

3.7 Menu navigation on the receiver control panel
The  and  buttons have different functions depending on the operating situation. These functions 
are displayed at the left edge of the display above the icons.

3.7.1 Meaning of the display icons

Level 1 Level 2 Description 

Language English German French Italian Spanish

Operating mode Process mode Alignment

Visibility Off Dark Normal Bright Dynamic

Time Unit (s) (enter value)
min = 1
max = 240

Evaluation function TIB TNIB FIB FNIB LIB LNIB

Level 1 Level 2 Description 

Product name CML 720i Ex

Product ID Receiver Part No. (e.g., 50119835)

Serial number Receiver serial no. (e.g., 01436000288)

Transmitter ID Transmitter Part No. (e.g., 50119407)

Transmitter SN Transmitter Serial No. (e.g., 01436000289)

FW Version e.g. 02.40

HW Version e.g., A001

Kx Version e.g., P01.30e

Icon Position Function

First line
Symbolizes that you can select the next parameter within a menu level by 
pressing the  button.

First line
Symbolizes that you have reached the lowest menu level (not highlighted).

Second line
Symbolizes the respective, next menu level that you have not yet selected 
(not highlighted).

Second line
Press the  button to exit the menu level or the menu.

Second line
Symbolizes the input mode.
The selected (highlighted) option field can be a fixed selection parameter or a 
multi-digit input field. With a multi-digit input field, you can increase the active 
digit by one with the  button and use the  button to switch from one 
digit to the next.
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3.7.2 Level display
The display of bars between icons and text that span both lines indicates the open menu levels. The 
example shows a configuration in the menu level 2:

3.7.3 Menu navigation

3.7.4 Editing value parameters

Second line
Symbolizes the confirmation of a selection.
This icon appears when you complete an option field with the  button.

Second line
Symbolizes the rejection of a selection.
This icon is accessed from the previous icon (check mark) by pressing 
the  button. This mode allows you to reject the current value or option 
parameter by pressing the  button.

Second line
Symbolizes the return to the selection.
This icon is accessed from the previous icon (cross) by pressing 
the  button. This mode allows you to reset the current value or option 
parameter for the purpose of entering a new value or selecting an option 
parameter by pressing the  button.

Icon Position Function

Start Beam

End beam

Main Settings

Digital IOs

Selects the next menu item (“Digital IOs”); the other menu items follow if pressed again.

Selects the highlighted submenu (“Main Settings”).

Start Beam

End beam

Selects the “Start Beam” menu item with the bright background.
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After entering the last number, the total value can be saved, rejected or reset.

If the selected option is not saved in the window above, but rather the  action mode is selected with 
the  button, this means:

If the  action mode is selected with the  button, this means:

Start beam

0001

Changes the value of the first digit (0).

Selects additional numbers for configuring values.

Start beam

0010

Saves the new value (0010).

Changes the action mode; first  and then  appears on the second line.

Start beam

0010

Rejects the current input value. The display returns to the higher-order menu level: Start Beam/
End Beam

Start beam

0010

Resets the current input value (0001) and allows the entry of new values.
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3.7.5 Editing selection parameters

IO Logic

IO Pin 2

Selects the “IO Logic” menu item with the bright background.

IO Logic

Positive PNP

With each actuation, displays the next option on this menu level, i.e., the display switches 
between:

• Negative NPN
• Positive PNP

Selects the “Positive PNP” menu item with the bright background.

IO Logic

Positive PNP

Changes the action mode;  appears; subsequent actuation displays  or  again.

Saves the selected option “Positive PNP”.
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4 Functions
This chapter describes the functions of the light curtain for adaptation to different applications and oper-
ating conditions.

4.1 Beam modes

4.1.1 Parallel
In “parallel” beam mode (parallel-beam scanning), the light beam of each transmitter LED is detected by 
the directly opposing receiver LED.

Figure 4.1: Beam path in “parallel”

4.1.2 Diagonal
In “diagonal” beam mode, the light beam of each transmitter diode is received in succession both by the 
directly opposing receiver diode as well as by the next receiver diode in the counting direction (i-1) (parallel 
and diagonal beam path). This increases the resolution in the middle between the transmitter and receiver.

1 Area with increased resolution
Figure 4.2: Beam path in “diagonal”

Calculation
The number of beams for diagonal-beam scanning np is calculated from the number of beams for parallel-
beam scanning nd. 

1
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Formula for calculating the number of beams for diagonal-beam scanning

nd [number] = number of beams for diagonal-beam scanning
np [number] = number of beams for parallel-beam scanning

Example: 288 beams in parallel-beam scanning become 575 logical individual beams in diagonal-beam 
scanning, which must be taken into account during evaluation functions. With a beam spacing of 5 mm, 
this spacing is reduced to 2.5 mm in the center area.

4.1.3 Crossed-beam
The “crossed-beam” mode (crossed-beam scanning) is available for increasing the resolution for an area 
of the measurement field. In “crossed-beam” mode, the light beam of each transmitter LED is detected in 
succession both by the directly opposing receiver LED as well as by the two adjacent receiver LEDs (i+1, 
i-1).

1 Area with increased resolution
Figure 4.3: Beam path in “parallel”

The “diagonal” beam mode (diagonal-beam scanning) can be activated via the respective field-            
bus interface (see chapter 9 et seq.) or via the Sensor Studio  configuration software (see               
chapter 12).

NOTICE
Minimum distance for diagonal-beam scanning!
 For diagonal-beam scanning, the minimum distance that must be maintained between transmitter and 

receiver changes, whereby the values vary depending on beam spacing (see chapter 16).

NOTICE
Teach after changing the beam mode!
 Changing the beam mode changes the number of beams used for the evaluation. Perform a teach 

after changing the beam mode (see chapter 8.2).

nd 2np 1–=

1
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Calculation
The number of beams for crossed-beam scanning np is calculated from the number of beams for parallel-
beam scanning nk.

Formula for calculating the number of beams for crossed-beam scanning

nK [number] = number of beams for crossed-beam scanning
np [number] = number of beams for parallel-beam scanning

Example: 288 beams in parallel-beam scanning become 862 logical beams in crossed-beam scanning. 
With a beam spacing of 5 mm, this spacing is reduced to 2.5 mm in the center area.

4.2 Measurement beam sequence
By default, the counting direction of the beams begins at the sensor connection unit. It can, however, be 
reconfigured so that counting begins with 1 at the sensor head.
The simplest application case for the inverted beam sequence is vertical mounting with the connection unit 
at the top, e.g., for height measurement, where beam 1 is to begin at the bottom:

a Receiver connection unit
b Optical part

Another variant with two successive light curtains, where the second is rotated by 180° and counting again 
begins with 1, is illustrated as follows:

a Receiver connection unit
b Optical part

For width detection, counting can begin with 1 at either end at the head part of the sensor as shown below:

NOTICE
Minimum distance for crossed-beam scanning!
 For crossed-beam scanning, the minimum distance that must be maintained between transmitter and 

receiver changes, whereby the values vary depending on beam spacing (see chapter 16).

The “crossed-beam” mode (crossed-beam scanning) can be activated via the respective fieldbus           
interface (see chapter 9 et seq.) or via the Sensor Studio configuration software (see             
chapter 12).

nk 3np 2–=

a

b

1

... n

a

1 ... n

b b a

1 ... n
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a Receiver connection unit
b Optical part

4.3 Beam-stream
The single-beam evaluation (beam-stream) returns the status of each individual beam (see figure 4.4). 
Uninterrupted beams (free beams) are represented as logical 1 in the output bit in this case. 

1 Beam-stream

Figure 4.4: Example: beam-stream evaluation

4.4 Evaluation functions
The states of the individual optical beams (free/interrupted) can be evaluated in the CML 700i and the 
result read out via various evaluation functions.
The most important evaluation functions are shown in the following figure:

The counting direction can be changed via the respective fieldbus interface (see chapter 9 et              
seq.) or via the Sensor Studio configuration software (see chapter 12).

a

1 ... n

b b a

n ... 1

The data is available via the respective fieldbus interface (see chapter 9 et seq.) or via the                
Sensor Studio configuration software (see chapter 12).

For an example configuration, see chapter 11.1.

1   1   1   1   1   0 1   1   1   1   1   10   0   0   11

16

1
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1 Total of interrupted beams (TIB)
2 Total of not interrupted beams (TNIB)
3 Last interrupted beam (LIB)
4 Last not interrupted beam (LNIB)
5 First not interrupted beam (FNIB)
6 First interrupted beam (FIB)

Figure 4.5: Evaluation functions

Also included among the evaluation functions are:
• the status of beam areas 1 … 32
• the status of the digital inputs/outputs

For the beam area mappings to an output pin or the status of the digital inputs/outputs, see chapter 4.10.

4.5 Hold function

The minima and maxima of the following evaluation functions can be temporarily stored for an adjustable 
period of time via this function:

• First interrupted beam (FIB)
• First not interrupted beam (FNIB)
• Last interrupted beam (LIB)
• Last not interrupted beam (LNIB)
• Total of interrupted beams (TIB)
• Total of not interrupted beams (TNIB)
• Single-beam evaluation (beam-stream): A beam that has been interrupted once is kept at logical 0 in 

the output bit until the hold time has expired.
Temporary storage simplifies the reading out of the measurement results if the used control cannot 
transmit the data at the same speed that the light curtain makes the data available.

4.6 Blanking
If light curtains are installed such that existing frames / cross bars etc. continuously interrupt some beams, 
these beams must be suppressed.
During blanking, beams that are not to be included in the evaluation are suppressed. The numbering of 
the beams is not affected, i.e., the suppression of beams does not change the beam numbers.

1

6

3

2

2
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4

The setting of the hold times is performed via the respective fieldbus interface (see chapter 9 et                
seq.) or via the Sensor Studio configuration software (see chapter 12).
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1 Interrupted beams
2 Suppressed beams (blanking)
3 Free beams
4 Object present at the installation site

Figure 4.6: Beam states

The behavior of each blanking area can be adapted to the requirements of the application:

For an example configuration, see chapter 11.4.

Auto blanking during teaching
If there are obstacles present in the measurement field at the installation site and at least one blanking 
area is activated, interrupted beams can be mapped to the blanking area(s) during teaching. Existing 
settings for the blanking areas are then overwritten (see chapter 8.2). 
If no beams are interrupted during teaching, no blanking areas are configured.

Up to four adjacent beam areas can be suppressed.

The beams can be activated or suppressed via the respective fieldbus interface (see chapter 9              
et seq.), via the Sensor Studio configuration software (see chapter 12) and partially via the ope-               
rational controls on the receiver.
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Logical value of a blanking area Meaning in the application

No beams are blanked All beams of the device are included in the evaluation.

Logical value 0 for blanked beams All beams of the blanking area are taken into account 
as interrupted beams (logical value 0) in the evalua-
tion.

Logical value 1 for blanked beams All beams of the blanking area are taken into account 
as free beams (logical value 1) in the evaluation.

Logical value is the same as the adjacent 
beam with lower beam number

All beams of the blanking area behave in the evalua-
tion like the previous beam.

Logical value is the same as the adjacent 
beam with higher beam number

All beams of the blanking area behave in the evalua-
tion like the subsequent beam.

NOTICE
Teach after changing the blanking configuration!
 Perform a teach after changing the blanking configuration (see chapter 8.2).
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4.7 Power-Up Teach
After applying operating voltage, the “Power-Up Teach” function performs a teach event when the device 
is ready for operation.

• If the Power-Up teach is successful, the new teach values are adopted if they are different from the 
previously stored teach values.

• If the Power-Up teach is not successful (e.g. object in the light path), the previously saved teach val-
ues are used. 

If the Auto blanking function is activated via the receiver control panel, up to four blanking areas                
are automatically permitted.

Auto blanking cannot be used to detect transparent objects.

Deactivated beams are lost if the beam mode is changed while auto blanking is active.

NOTICE
Deactivate auto blanking in process mode!
 Deactivate auto blanking in process mode.

Activate auto blanking only during commissioning of the device to suppress distracting objects.

NOTICE
Deactivate auto blanking during Power-Up Teach!
 Deactivate auto blanking if “Power-Up Teach” is activated (see chapter 4.7).

NOTICE
Resetting all blanking areas!
 To deactivate blanking areas, leave auto blanking active with at least the same number of blanking 

areas.
Perform a new teach in a free measurement field.

 To deactivate blanking with the Sensor Studio configuration software, configure the number of blan-
king areas as zero and, at the same time, deactivate each area.
Perform a new teach.

The “Power-Up Teach” event can only be activated via the receiver control panel.

NOTICE
Deactivate auto blanking during Power-Up Teach!
 Deactivate auto blanking if “Power-Up Teach” is activated.

NOTICE
No objects in the light path!
 During “Power-Up Teach”, ensure that no beams are partially covered by an object.
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4.8 Smoothing
With the smoothing function, interrupted beams are then only taken into account in the evaluation if the set 
minimum number of adjacent beams is reached at the same time.
Smoothing can be used, e.g., to suppress interference caused by spot soiling of the lens cover.
Smoothing “1” means that every interrupted beam is evaluated.

1 Data output: beam number x interrupted
Figure 4.7: Smoothing configuration “1”

If smoothing is set to a value of “3”, for example, data is only output if at least three adjacent beams are 
interrupted. 

1 Data output: 0 beams interrupted
Figure 4.8: Smoothing configuration “3”, but no more than two adjacent beams interrupted

1

1
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1 Data output: beam numbers from … to … interrupted
2 Interrupted beam is not taken into account

Figure 4.9: Smoothing configuration “3”, and three or more adjacent beams interrupted

Inverted smoothing
Inverted smoothing can suppress interference near the edges of objects, since uninterrupted beams are 
not evaluated until the set number is reached.
With inverted smoothing it is possible to detect, e.g., only successive openings of a certain minimum size 
within a web.
For an example configuration, see chapter 11.5.

4.9 Cascading/triggering
If the measurement field length of a light curtain is not sufficient for detecting a desired measurement path, 
multiple light curtains can be connected in series or cascaded. When doing so, it must be ensured that the 
light curtains do not mutually influence or interfere with one another. This is ensured by activating (trig-
gering) with a time offset.

The following light curtain arrangements are possible in a cascade arrangement:
• Multiple light curtains above one another, e.g., for height monitoring

NOTICE
Configuration values for smoothing!
  Values from 1 to 255 can be entered for smoothing.

1

2
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1 Light curtain 1
2 Light curtain 2

Figure 4.10: Simple cascading with two light curtains for height monitoring

• Multiple light curtains in a rectangular frame, e.g., for object measurement of height and width along 
a transport system.

1 Light curtain 1
2 Light curtain 2
3 Light curtain 3

Figure 4.11: Simple cascading with three light curtains for object measurement

The selection of activation via an internal or external trigger signal is made via the respective               
fieldbus interface (see chapter 9 et seq.) or via the Sensor Studio configuration software (see              
chapter 12).

NOTICE
Cascading necessary for multiple-track transport systems!
 Cascade light curtains for multiple-track transport systems.
 Prevent mutual interference through sequential activation of the light curtains. 

If the spatial configuration excludes mutual interference, multiple light curtains can also be activated 
simultaneously.
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4.9.1 External triggering

Trigger input
For an exact time assignment, it is possible to start the measurement cycle of a light curtain in a targeted 
manner by means of a pulse at the trigger input. In this way, mutual interference can be prevented in appli-
cations with multiple light curtains. This trigger signal generated in the control must be wired at all 
cascaded light curtains.
The individual light curtains are configured so that the respective measurement is started with different 
delay times to the trigger pulse (see figure 4.12).

1 PLC
2 Light curtain 1, delay time = 0 ms
3 Light curtain 2, delay time = 11 ms (depending on the cycle time LC1)
4 Trigger signal (PLC)

Figure 4.12: Activation via external trigger

4.9.2 Internal triggering
With internal trigger activation, a CML 700i configured as "master light curtain" generates the trigger pulse. 
This trigger pulse is continuous; this means that no further activation is required from a primary control.

Trigger output
The trigger output of the master light curtain makes available the trigger signal necessary for “cascading 
via internal trigger”. The trigger output must be wired to the trigger inputs of the slave light curtains (see 
figure 4.13). This is used to start the measurement in the configured time sequence.

The following figure shows a wiring example for the cascading of three light curtains via internal trigger:

0 10

LV1

LV2

11 32

t [ms]

2 3

1

4

The cycle time of the respective light curtain can be read out via the Sensor Studio configuration                
software (see chapter 12) or via the respective fieldbus interface (see chapter 9 et seq.).

The selection of activation via an internal or external trigger signal is made via the respective               
fieldbus interface (see chapter 9 et seq.) or via the Sensor Studio configuration software (see              
chapter 12).

For an example configuration, see chapter 11.6.
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1 Trigger In (on X1, e.g. pin 5)
2 Slave light curtain 3
3 Slave light curtain 2
4 Master light curtain 1
5 Trigger Out (on X1, e.g. pin 5)

Figure 4.13: Wiring example of three light curtains via internal trigger

The following example shows a configuration of three light curtains via internal trigger.

1 Master light curtain LC1
2 Slave light curtain LC2
3 Slave light curtain LC3
4 Total cycle time

Figure 4.14: Example: cascading via internal trigger

4.10 Block evaluation of beam areas
With this function, the quantity of data to be transmitted can be reduced by restricting the imaging accu-
racy. The minimum resolution of the light curtain is still retained.
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4.10.1 Defining beam area
To read out the beam states block-wise with a 16-bit or 32-bit telegram, the individual beams can be 
mapped to up to 32 areas independent of the maximum beam number. The individual beam information 
of grouped beams is linked to a logical bit, i.e., each area is represented as 1 bit.
The number of beams in an area can be freely defined. However, the beams must be adjacent to one 
another. The start beam and the end beam are to be defined as well as the conditions for switching of the 
area.

4.10.2 Autosplitting
The beams of the device are automatically divided into the selected number of areas of the same size. The 
states of the areas generated in this way can be read out in the process data by means of the “Area Out - 
HiWord” and “Area Out - LoWord” parameters.

Procedure:
• Select logic combination of the beams within the areas (logical AND / logical OR)
•  Define the number of desired areas (e.g., 16 or 32)

4.10.3 Mapping beam area to switching output
If grouping individual beams or if creating a block, the beam state of any number of adjacent beams (area) 
can be signaled at a switching output. 

There are, thus, the following possibilities:
• To use a specific, single beam for the evaluation, e.g., as trigger signal for a primary control.
• To group the complete measurement field into one switching area and thereby signal at the switching 

output whether an object (at any position) is located in the measurement field.
• To configure up to 32 switching areas for a reference check or height monitoring; in many cases, this 

can make beam-data processing in the primary programmable logic control (PLC) unnecessary.
The switching conditions for the areas can be either AND or OR linked:

Areas may be sequential or overlapping. A maximum of 32 areas are available. 

NOTICE
Hold function for beam areas!
 The hold function (see chapter 4.5) also applies for the block evaluation of beam areas.

The autosplitting configuration can be defined via the respective fieldbus interface (see chapter 9             
et seq.) or via the Sensor Studio configuration software (see chapter 12).

Logic func-
tion

Group bit (area status)
[logic 1/0]

AND 1 If all beams mapped to the area are interrupted

0 If at least one beam is not interrupted in the selected area

OR 1 If at least one beam is interrupted in the selected area

0 If none of the beams mapped to the area are interrupted

The switching behavior or the conditions for switching a beam area on and off can be defined via                 
the respective fieldbus interface (see chapter 9 et seq.) or via the Sensor Studio configuration              
software (see chapter 12).

For an example configuration, see chapter 11.2.
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Example for the configuration of an OR or AND link for a light curtain with 32 beams

 
The following figure shows how the beam areas can be arranged directly next to one another or freely over-
lapping.

1 Beam area 1
2 Beam area 2
3 Beam area 3
4 Beam area 4

Figure 4.15: Beam areas

For a mapping of previously defined beam areas to, e.g., four switching outputs (Q1 to Q4), see 
chapter 11.2. 

4.10.4 Teach height area
With the Teach height area function, it is possible to teach in up to four height areas, e.g. for height moni-
toring or sorting packets. In many cases, this reduces time for programming.

• A maximum of four height areas are available.
• A height area is automatically defined using an object.

When teaching a height area, all free beams above or below the object are combined into one height 
area. Therefore, the object cannot be located in the center of the measurement field length; the first 
or last beam must be interrupted.

OR AND

Start beam 1 1

End beam 32 32

Switch-on condition 1 beam interrupted 32 beams interrupted

Switch-off condition 0 beams interrupted 31 beams interrupted

NOTICE
Increased number of logical beams for the diagonal- or crossed-beam function!
 Take into account the (increased) number of beams if the “diagonal”- or “crossed-beam” mode is acti-

vated (see chapter 4.1.2 or see chapter 4.1.3).
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1 Teaching height area 1
2 Teaching height area 2

Figure 4.16: Teaching the height area with the Teach in height area function 

• To define the entire beam area as a height area, teaching of the height area is performed without an 
object (all beams free).

Figure 4.17: Teaching of the total beam area as height area without object

• The switching behavior or the conditions for switching the height area on or off via the Teach height 
area function is permanently defined as OR.

• Every IO pin can be assigned to a height area via the receiver control panel. 
Example: Digital IOs > IO Pin 2 > Teach height > Execute

Example configurations for the assignment of previously defined height areas to switching outputs Q1 to 
Q4:

• see chapter 11.2 "Example configuration - Mapping of beams 1 … 32 to output pin 2"

On the receiver control panel, the Teach height area function is activated via the Teach height               
menu item. Example: Digital IOs > IO Pin 2 > Teach height > Execute

If the Teach height area function is activated via the receiver control panel, the IO pins are auto-                 
matically assigned to the height areas.

1 2
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4.11 Switching outputs

4.11.1 Light/dark switching
The behavior of switching outputs Q1 to Q4 (or Q1 to Q2) can be configured with respect to light/dark 
switching. The setting ex works is “light switching”, i.e., the outputs are activated if the light paths are free 
and become inactive if an object is detected in the measurement field.

4.11.2 Time functions
Each of the individual switching outputs can be assigned one of the time functions described in the 
following table.

4.12 Interference suppression (filter depth)
To suppress any faulty measurement values that may occur due to interference (ambient light, electromag-
netic fields, …), the filter depth of the light curtain can be increased.
“Filter depth” means that an interrupted/free beam is not included in the further data evaluation until the 
same beam status is recorded for the set number of measurement cycles.

NOTICE
Error message during teach-in of the height area using the configuration software!
If the detection field of the light curtain is not free when the Teach height area function is executed using 
the Sensor Studio configuration software, an error message is displayed.
 Remove all objects located in the detection field of the light curtain. 
 Restart the Teach height area function.

The output behavior can be changed to “dark switching” via the respective fieldbus interface (see              
chapter 9 et seq.), via the receiver control panel and via the Sensor Studioconfiguration software              
(see chapter 12).

The accuracy of the switching delay is dependent on the measurement frequency. Observe this             
especially in cascaded operation.

Time function Selectable
Duration

Description

Start-up delay
with re-trigger

0 … 65000 ms Time that the sensor delays the start-up process after 
detecting an object.
By means of a start-up delay, it is possible to suppress, 
e.g., upward-protruding packaging remnants (stretch 
wrap, etc.) during pallet height monitoring.

Switch-off delay
with re-trigger

0 … 65000 ms Time that the sensor delays the switching back of the 
output if the object leaves the detection range.

Pulse stretching 0 … 65000 ms Minimum time that the state of the output is retained 
independent of what the sensor detects during this time.
Pulse stretching is necessary for, e.g., hole recognition if 
the PLC cycle time does not register short pulses.

Pulse suppression
with re-trigger

0 … 65000 ms Minimum time that a measurement signal must be pres-
ent in order for the output to switch. Short interference 
pulses are thereby suppressed.

The various time functions can be configured via the respective fieldbus interface (see chapter 9              
et seq.) or via the Sensor Studio configuration software (see chapter 12).
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Filter depth “1” = the beam states of each measurement cycle are output.
Filter depth “3” = only those beam state changes that were stable over three measurement cycles are 
output.

Filter depth can be configured via the respective fieldbus interface (see chapter 9 et seq.) or via                
the Sensor Studio configuration software (see chapter 12).

At maximum receiving sensitivity, the receiver reacts to extremely minor violations of the detec-             
tion field.

To debounce the validation signal, it is recommended to configure a waiting time of 100 ms in                
the control.

After the device has been switched on, measurement readiness is NOT signaled when triggering             
is activated and the trigger-input signal is missing.
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5 Applications
The following typical applications with corresponding evaluation function (see chapter 4) exist for the 
measuring light curtain.

5.1 Height measurement

Figure 5.1: Height measurement

 Evaluation function: Last interrupted beam (LIB).
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5.2 Object measurement

Figure 5.2: Object measurement

 Height evaluation function: Last interrupted beam (LIB).
Width evaluation function: Total of interrupted beams (TIB).
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5.3 Width measurement, orientation detection

Figure 5.3: Width measurement, orientation detection

 Evaluation function for width measurement: Total of interrupted beams (TIB).
 Evaluation function for orientation detection: Single-beam evaluation (beam-stream) or first/last inter-

rupted beam (FIB/LIB).
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5.4 Contour measurement

Figure 5.4: Contour measurement

 Evaluation function: Single-beam evaluation (beam-stream).

5.5 Gap control/gap measurement

Figure 5.5: Gap control/gap measurement
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 Evaluation function: Single-beam evaluation (beam-stream).

5.6 Hole recognition
For a detailed configuration example see chapter 11.3.

Figure 5.6: Hole recognition

 For hole recognition within a web material, a beam area must be defined over the area to be monitored 
and mapped to an output. All beams in this area are interrupted. If a beam becomes “free” due to a flaw 
in the material, the output switches.

 If, for example, the web edge wanders slightly, the beam area can be dynamically adapted by “tracking” 
the start beam by selecting the First interrupted beam (FIB) evaluation function and the end beam by 
selecting the Last interrupted beam (LIB) evaluation function.
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6 Mounting and installation

6.1 Mounting the light curtain

Mount the transmitter and receiver as follows:
 Select the fastening type for transmitter and receiver.

- Fastening via the T-groove on one side of the standard profile (see chapter 6.3).
- Fastening via the rotating bracket on the ends of the profile (see chapter 6.4).
- Fastening via the swiveling mounting brackets or parallel brackets (see chapter 6.5).

 Have a suitable tool at hand and mount the light curtain in accordance with the notices regarding the 
mounting locations.

Mount the transmitter and receiver at the same height or with the same housing reference edge, free of 
tension and with the base in full contact with the mounting surface.

 Secure transmitter and receiver against turning or sliding.

WARNING
Safe use of the sensor in potentially explosive areas!
 Observe the information on the safe use of sensors in potentially explosive areas; see chapter 2.5.

NOTICE
No reflective surfaces, no mutual interference!
 Avoid reflective surfaces near the light curtains.

Objects may otherwise not be precisely detected due to halation.
 Ensure sufficient distance, suitable positioning or partitioning. 

Optical sensors (e.g., other light curtains, photoelectric sensors, etc.) must not interfere with one 
another.

 Avoid interference from outside light (e.g., from flash lamps, direct sunlight) on the receiver.

NOTICE
Must be observed!
 For horizontally mounted measuring light curtains with lengths of more than 2,000 mm, use an addi-

tional mounting bracket in the middle of the light curtain.
 The optical surfaces of transmitter and receiver must be parallel to and opposite one another.
 The transmitter and receiver connections must point in the same direction.
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1 Same height position / upper edge, same alignment
2 Parallel alignment
3 Receiver
4 Transmitter

Figure 6.1: Arrangement of transmitter and receiver

After mounting, you can electrically connect (see chapter 7) and start up (see chapter 8) the light curtain.

6.2 Definition of directions of movement
The following terms for alignment movements of the light curtain around one of its individual beams are 
used:

a Sliding: movement along the longitudinal axis
b Turning: movement around the longitudinal axis
c Tilting: lateral turning movement diagonal to the lens cover
d Pitching: lateral turning movement in the direction of the lens cover

Figure 6.2: Directions of movement during alignment of the light curtain

To achieve the maximum operating range limit, transmitter and receiver must be aligned with one              
another as accurately as possible.

4 3

1 2

2

a) b) c) d)
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6.3 Fastening via sliding blocks
By default, transmitter and receiver are delivered with two sliding blocks (three sliding blocks for measure-
ment field lengths of more than 2,000 mm) each in the side groove (see chapter 17).
 Fasten transmitter and receiver to the machine or system via the lateral T-groove with M6 screws.

Figure 6.3: Mounting via sliding blocks

6.4 Fastening via swivel mount
When mounting with the BT-2R1 swivel mount (see table 17.8), sold separately, the light curtain can be 
aligned as follows:

• Sliding through the vertical threaded holes in the wall plate of the swivel mount
• Turning by 360° around the longitudinal axis by fixing on the screw-on cone
• Tilting around main axis
• Pitching through horizontal threaded holes in the wall mounting

The wall mounting through threaded holes makes it possible to lift the mounting bracket after the screws 
have been loosened over the connection cap. Therefore, the mounting brackets do not need to be 
removed from the wall when exchanging the device. Loosening the screws is sufficient.

Figure 6.4: Mounting via swivel mount

Sliding in the direction of the groove is possible, but turning, tilting and pitching is not.
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One-sided mounting on the machine table
The sensor can be mounted directly on the machine table via an M5 screw on the blind hole in the end 
cap. On the other end, a BT-2R1 swivel mount can be used, for example, so that turning movements for 
alignment are possible despite the fact that the sensor is mounted on one side. 

Figure 6.5: Mounting directly on the machine table

6.5 Fastening via swiveling mounting brackets
When mounting with the BT-2SSD/BT-4SSD or BT-2SSD-270 swiveling mounting brackets (see 
table 17.8), sold separately, the light curtain can be aligned as follows:

• Sliding in the direction of slot
• Turning +/- 8° around the longitudinal axis

The BT-SSD (see figure 16.6) swiveling mounting brackets are also equipped with a vibration damper.

NOTICE
Avoid reflection bypasses at the machine table!
  Make sure that reflections on the machine table and in the vicinity are prevented reliably.
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7 Electrical connection

7.1 Shielding and line lengths
The light curtains are equipped with modern electronics developed for industrial applications. In industrial 
environments, a number of sources of interference may affect the light curtains. 
In the following, information is provided on the EMC-compliant wiring of the light curtains and the other 
components in the switch cabinet.

7.1.1 Shielding

WARNING
Safe use of the sensor in potentially explosive areas!
 Observe the information on the safe use of sensors in potentially explosive areas; see chapter 2.5.

NOTICE
General shielding information!
 Avoid interference emissions when using power components (frequency inverters, …). 

The necessary specifications under which the power component satisfies its CE Declaration of Con-
formity can be found in the technical descriptions of the power components.
In practice, the following measures have proven effective:
Properly ground the total system.
Screw mains filter, frequency inverter, etc., flat to a galvanized mounting plate (thickness 3 mm) in the 
switch cabinet.
Keep cable between mains filter and inverter as short as possible and twist cables.
Shield both ends of the motor cable.

 Carefully ground all parts of the machine and of the switch cabinet using copper strips, ground rails or 
grounding cables with large cross section.

 Keep the length of the shieldless end of the cable as short as possible.
 Guide the shielding untwisted to a terminal (no “RF braid”).

NOTICE
Separate power and control cables!
 Devices with connector must be equipped with a safeguard or a mechanical interlocking guard; see 

table 17.9.
 Lay the cables for the power components (mains filter, frequency inverter, …) as far from the light cur-

tain cables as possible (distance > 30 cm). 
 Avoid laying power and light curtain cables parallel to one another.
 Cable crossings should be laid as perpendicular as possible.

NOTICE
Lay cables close to grounded metal surfaces!
 Lay the cables on grounded metal surfaces

This measure reduces interference coupling in the cables.

NOTICE
Avoid leakage currents in the cable shielding!
 Carefully ground all parts of the machine.

Leakage currents arise from incorrectly implemented equipotential bonding.
You can measure leakage currents with a clip-on ammeter.
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Grounding the light curtain housings
 Connect the transmitter housing and receiver housing of the light curtain to the protective conductor on 

the FE machine star point via the PE screw on the grounding slot nut (see figure 7.1).
The cable should have an impedance as low as possible for high-frequency signals, i.e., be as short as 
possible and have a large cross-sectional area (grounding strip, …).

 Use a lock washer and check the penetration of the anodized layer.
 Check the small Allen screw to ensure a secure connection between the grounding slot nut and housing.

The Allen screw is correctly tightened upon delivery from the factory.
If you have changed the position of the grounding slot nut or the PE screw, tighten the small Allen screw.

Figure 7.1: Connecting the ground potential to the light curtain

Example for shielding both ends of the connection cables from the switch cabinet to the light curtain
 Ground the transmitter housing and receiver housing of the light curtain (see chapter  "Grounding the 

light curtain housings").
 Clamp the shield in the switch cabinet flat to FE (see figure 7.2).

Use special shielding terminals (e.g., Wago, Weidmüller, …). 

Figure 7.2: Connecting the cable shielding in the switch cabinet

NOTICE
Star-shaped cable connections!
 Ensure that the devices are connected in a star-shaped arrangement. 

You thereby avoid mutual influences from various loads.
This prevents cable loops.
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Example for shielding both ends of the connection cables from the PLC to the light curtain
 Ground the transmitter housing and receiver housing of the light curtain (see chapter  "Grounding the 

light curtain housings").
 Only lay shielded light curtain cables to the PLC.
 Clamp the shield flat to FE in the PLC (see figure 7.3).

Use special shielding terminals (e.g., Wago, Weidmüller, …). 
Make certain that the mounting rail is well grounded.

Figure 7.3: Connecting the cable shielding to the PLC

7.1.2 Cable lengths for shielded cables
 Observe the maximum cable lengths for shielded cables.

Table 7.1: Cable lengths for shielded cables

Designation of the interface connections: see chapter 7.3 "Device connections"

Depicted shielding components from Wago, series 790 …:

- 790 … 108 screen clamping saddle 11 mm

- 790 … 300 busbar holder for TS35

Depicted shielding components from Wago, series 790 …:

- 790 … 108 screen clamping saddle 11 mm

- 790 … 112 carrier with grounding foot for TS35

Connection to the CML 700i Interface Max. cable length Shielding

PWR IN/digital IO, IO-Link, analog X1 20 m required

PWR IN/digital IO (Y-connection cable and 
synchronization cable)

X1 20 m required

Synchronization cable analog/IO-Link X2/X3 20 m required

BUS IN /BUS OUT (Y-fieldbus cable) X2 40 m required
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7.2 Connection and interconnection cables

7.3 Device connections
The light curtain is provided with the following connections:

7.4 Digital inputs/outputs on connection X1

Figure 7.4: Digital input/output schematic diagram

7.5 Electrical connection – CML 720i Ex with CANopen or IO-Link interface
The electrical connection is established in the same way for all devices.

Use only the cables listed in the accessories (see chapter 17) for all connections (connection              
cable, analog/IO-Link/fieldbus interconnection cable, cable between transmitter and receiver).

Use only shielded cables for the cable between transmitter and receiver.

NOTICE
Competent persons and approved purpose!
 Only allow competent persons to perform the electrical connection.
 Select the functions so that the light curtain can be used as intended (see chapter 2.1).

Device con-
nection

Type Function

X1 on receiver M12 connector,
8-pin

Control interface and data interface:
• Voltage supply
• Switching outputs and control inputs
• Configuration interface
• Synchronization interface

(for devices with fieldbus interface)

X2 on receiver M12 socket,
4-/5-pin

Synchronization interface and fieldbus interface:
• Fieldbus interface (for CANopen and IO-Link devices)

X3 on trans-
mitter

M12 connector,
5-pin

Synchronization interface (for all controller types)

Ex works, input/output IO 1 (pin 2) is assigned the teach-in function and input/output IO 2 (pin 5)                 
is assigned the trigger-in function.

NOTICE
Single assignment of input functions!
 Each input function may only be used one time. If multiple inputs are assigned the same function, mal-

functions may occur.

X1-1

X1-6/7

GND

18 - 30 VDC

100 mA  (max. 250 mA)

X1-3

X1-2/5
10k

10k

X1-3



Electrical connection

Leuze electronic GmbH + Co. KG CML 720i Ex 52

1 Receiver (R)
2 Transmitter (T)
3 Y-fieldbus cable (M12 connector/socket, 5-pin), see table 17.5, see table 17.6
4 Y-connection cable and synchronization cable (M12 socket/connector, 8-pin/5-pin), see table 17.3

Figure 7.5: Electrical connection – CML 720i Ex with CANopen or IO-Link interface

 Connect connection X1 with the Y-interconnection cable; connect the short end to the power supply or 
configuration software interface and connect the long end to connection X3 on the transmitter.

 Connect connection X2 on the receiver with the Y-interconnection cable; use both ends to connect to 
BUS IN or BUS OUT on the other network devices.

7.5.1 Pin assignment – CML 720i Ex with CANopen or IO-Link interface

X1 pin assignment (logic and power on the receiver and connection to transmitter)
8-pin, M12 connector (A-coded) for connecting to PWR IN/digital IO and transmitter.

NOTICE
Light curtain grounding!
 Ground the light curtain before establishing an electrical connection or connecting the voltage supply 

(see chapter  "Grounding the light curtain housings").

For devices with IO-Link interface in operation, the X2 connection on the receiver is not assigned.

The Y-fieldbus cable (3) is not required.

X1 X2 X3

BUS IN

BUS 
OUT

PWR IN/Digital IO

1 2

3

4
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1 M12 connector (8-pin, A-coded)
2 M12 connector (5-pin, A-coded)

Figure 7.6: X1/X3 connection

Table 7.2: X1/X3 pin assignment – CML 720i Ex with CANopen or IO-Link interface

Connection cables: see table 17.3, see table 17.7

Pin assignment on the short end of the Y-interconnection cable (PWR IN/digital IO)
5-pin, M12 connector (A-coded) on the short end of the Y-interconnection cable for connecting to PWR IN/
digital IO.

1 M12 connector (5-pin, A-coded)
Figure 7.7: X1 connection - PWR IN/digital IO

Table 7.3: X1 pin assignment – PWR IN/digital IO

1 2

Pin (X1) X1 - Logic and power on the receiver and connection to transmitter Pin (X3)

1 VIN: +24 V DC supply voltage 2

2 IO 1: input/output (configurable)

3 GND: ground (0 V) 3

4 C/Q: IO-Link communication

5 IO 2: input/output (configurable)

6 RS 485 Tx-: synchronization 5

7 RS 485 Tx+: synchronization 4

8 SHD: FE functional earth, shield 1

1

PWR IN/Digital IO

Pin X1 – Short end of the Y-interconnection cable

1 VIN: +24 V DC supply voltage

2 IO 1: input/output (configurable)
Ex works: teach input
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Connection cables: see table 17.4

Pin assignment on the long end of the Y-interconnection cable (PWR IN/digital IO)
The pin assignment on the long end of the Y-interconnection cable for synchronization of transmitter and 
receiver for devices with fieldbus interface is the same as for IO-Link .

X3 pin assignment (transmitter)
Pin assignment on the transmitter: see table 7.2
Connection cables: see table 17.3

7.5.2 X2 pin assignment – CML 720i Ex with CANopen-interface
5-pin, M12 connector (A-coded) for a device with CANopen interface for connecting to BUS IN/BUS OUT.

1 M12 socket (5-pin, A-coded)
Figure 7.8: X2 connection – CML 720i Ex with CANopen interface

Table 7.4: X2 pin assignment – CML 720i Ex with CANopen interface

Interconnection cables: see table 0.18

7.6 Electrical supply
With regard to the data for the electrical supply, see table 16.6.

3 GND: ground (0 V)

4 C/Q: IO-Link communication

5 IO 2: input/output (configurable)
Ex works: trigger input

Pin X1 – Short end of the Y-interconnection cable

1 2

Pin X2 – CANopen interface

1 SHD: FE functional earth, shield

2 n.c.

3 CAN_GND: ground (0 V)

4 CAN_H:

5 CAN_L:
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8 Starting up the device - Basic configuration
The basic configuration includes the alignment of transmitter and receiver and the basic configuration 
steps via the receiver control panel.
The following optional basic functions for operation and configuration are available at the receiver control 
panel (see chapter 8.5 "Extended configurations on the receiver control panel menu"):

• Define digital inputs/outputs
• Inversion of the switching behavior
• Defining the filter depth
• Defining the display properties
• Changing the language
• Product information
• Resetting to factory settings

8.1 Aligning transmitter and receiver

Prerequisites:
• The light curtain has been mounted (see chapter 6) and connected (see chapter 7) correctly.

 Switch on the light curtain.

 Check whether the green LEDs on the receiver control panel and transmitter illuminate continuously.
The display shows the alignment state of the first beam (FB) and last beam (LB) via two bar graph indica-
tors.

Figure 8.1: Example: display showing an incorrectly aligned light curtain

 Loosen the fastening screws of the transmitter and receiver.

 Turn or slide the transmitter and receiver until the optimum position is reached and the bar graph indi-
cators show the maximum values for the alignment.

NOTICE
Alignment during commissioning!
 The alignment performed during commissioning should only be performed by qualified personnel.
 Observe the data sheets and mounting instructions of the individual components.

NOTICE
Alignment mode!
When switched on for the first time ex works, the light curtain automatically starts in process mode.
 You can switch from process mode to alignment mode via the control panel.

Loosen the screws only enough so that the devices can just be moved.
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Figure 8.2: Display showing an optimally aligned light curtain

 Tighten the fastening screws of the transmitter and receiver.
Transmitter and receiver are aligned.

Switching to process mode
After aligning, switch to process mode.
 Select Display > Mode > Process mode.
The display in the receiver of the light curtain shows the process mode states with the total of interrupted 
beams (TIB) and the logic states of the digital inputs/outputs (digital IOs).

Figure 8.3: Display showing the process mode state of the light curtain

The structure of the configuration in the receiver control panel menu is as follows:

Switching to alignment mode
You can switch from process mode to alignment mode via the menu.
 Select Display > Mode > Alignment.
The structure of the configuration in the receiver control panel menu is as follows:

NOTICE
Minimum sensitivity of the sensor!
 In order to perform a teach, a minimum level must be reached in the bar graph indicator (mark in the 

middle of the display).

Level 0 Level 1 Level 2 Description

Display

Language English German French Spanish Italian

Operating 
mode

Process Mode Alignment

Level 0 Level 1 Level 2 Description

Display

Language English German French Spanish Italian

Operating 
mode

Process mode Alignment
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The next configuration step is teaching the environmental conditions (teach).

8.2 Teaching the environmental conditions
During teaching, the system checks whether the signals of all beams are within a certain corridor.
This means that a teach event generally regulates all beams to the preset function reserve (or sensitivity) 
for the current operating range. This ensures that all beams exhibit an identical switching behavior.

Prerequisites:
• The light curtain must be correctly aligned (see chapter 8.1).
• The bar graph indicator must show a minimum level. 

 You can use one of the following teach types: 
Teach via receiver control panel (see chapter 8.2.1).
Teach via teach input (see chapter 8.2.2).
Teach via fieldbus interface (IO-Link, see chapter 9; CANopen, see chapter 10).
Teach via Sensor Studio configuration software (see chapter 12).

8.2.1 Teach via receiver control panel
If blanking areas are configured via the configuration software interface, a teach event is performed that 
takes these blanking areas into account (blanking teach or auto blanking, see chapter 4.6).

NOTICE
Conditions for performing a teach!
When teaching without preconfigured blanking areas, the light path must always be completely free. 

A teaching error will otherwise occur.
 In this case, remove the obstacles and repeat the teach.
 If the light path is partially interrupted by structural elements, the permanently interrupted beams can 

be suppressed by means of blanking (auto blanking function). Interrupted beams are “deactivated” in 
this case.

 To automatically suppress the affected beams during teaching, configure the number of blanking 
areas via the configuration software Sensor Studio (see chapter 12).

The configuration can be performed via the respective fieldbus interface (see chapter 9 et seq.)              
or via the Sensor Studio configuration software (see chapter 12).

You can choose whether the teach values are to be stored permanently or only temporarily (while               
the operating voltage is applied). The configuration ex works is for permanent (non-volatile) stor-             
age.

A teach event can be performed both directly from process mode as well as from alignment               
mode.

NOTICE
Execute teach after changing the beam mode!
 Always perform a teach after changing the beam mode (parallel-/diagonal-/crossed-beam scanning) 

as well.

During a blanking teach or auto blanking, an “additional distance” is always added to the beams               
detected as interrupted. Safer operation is thereby achieved, e.g., in the case of vibrating guides,              
etc., in the “blanked” area.

Optimization of the blanked beams is to be performed via a software interface configuration.

A maximum of four adjacent areas of suppressed beams (blanking areas) can be configured. 
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The structure of the configuration in the receiver control panel menu is as follows:

 Select Main Settings > Command > Teach.
 Press the  button to execute the teach.
The display shows

If the teach was started while in process mode, the display returns to the process mode display after a 
successful teach (see chapter 8.1).
If the teach was started from alignment mode, the display returns to the bar graph indicator following a 
successful teach and shows the received signal level of the first beam (FB) and the last beam (LB) (see 
chapter 8.1).
If teach is successful, both bars display the maximum value.

Figure 8.4: Display after successful teach

If no bars are visible in the bar graph indicator for the first beam (FB) and the last beam (LB), an error has 
occurred. It is possible, e.g., that the reception signal is too low. You can correct errors according to the 
error list (see chapter 13).

Power-Up Teach
After applying operating voltage, the “Power-Up Teach”
The structure of the configuration in the receiver control panel menu is as follows:

 Select Main Settings > Operation Settings > Power-Up Teach > Active.

Level 0 Level 1 Level 2 Description 

Main Settings

Commands Teach Reset Factory settings

Waiting...

Level 0 Level 1 Level 2 Description 

Main Settings

Commands Teach Reset Factory settings

Operation Settings

Filter depth

Beam mode

Function reserve

Blanking Teach

Power-Up Teach Not active Active
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8.2.2 Teaching via a control signal from the control

Teach input (Teach In)
This input can be used to perform a teach following initial commissioning, change of the alignment or 
during operation. During this procedure, the transmitter and receiver adjust themselves to the maximum 
function reserve according to the distance.

To trigger a teach, a pulse must be applied on connection X1 on the receiver IO1 = pin 2 (factory setting) 
for longer than 20 ms … but less than 80 ms.
Depending on the configuration (PNP or NPN), this corresponds to the following signal response:

1 Teach is performed here
Figure 8.5: Control signals for line teach with PNP configuration

1 Teach is performed here
Figure 8.6: Control signals for line teach with NPN configuration

Performing a teach via the line input

Prerequisites:
• The light curtain must be correctly aligned (see chapter 8.1).
• A connection must be established between PLC and the line input (teach-in).

 Send a teach signal to the teach input via the control (see chapter  "Teach input (Teach In)" for the data) 
to trigger a teach.

The display on the receiver control panel shows

Following a successful teach, the display switches back to the bar graph (alignment mode).
If teach is successful, both bars display the maximum value.

Signal level for line teach with PNP configuration:

Low: ≤ 2 V; High: ≥ (UB-2 V

With the PNP configuration, the signal levels are inverted.

Waiting...

1

High

Low

1

High

Low
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Figure 8.7: Display after successful teach

The next configuration step is to check the alignment.

8.3 Check alignment

Prerequisites:
• The light curtain must first be correctly aligned and a teach must be performed.

 Check whether the green LEDs on the receiver control panel and transmitter illuminate continuously.
 Use the bar graph indicator to check whether the light curtain is optimally aligned, i.e., whether the max-

imum is reached for both the first beam (FB) and the last beam (LB) in the bar graph indicator.
 Use the bar graph indicator to check the optimum alignment of the light curtain if you have corrected an 

error that occurred.

The next configuration steps:
• Perform extended configurations on the receiver control panel if necessary (see chapter 8.5)
• Start up CML 700i light curtains with IO-Link interface (see chapter 9)
• Start up CML 700i light curtains with CANopen interface (see chapter 10)

8.4 Setting the function reserve
The function reserve can be set to three levels:

• High function reserve (low sensitivity)
• Medium function reserve
• Low function reserve (high sensitivity)

The function reserve can be set via the receiver control panel, via the respective fieldbus interface (see 
chapter 9 et seq.) or via the Sensor Studio configuration software (see chapter 12).

The structure of the configuration in the receiver control panel menu is as follows:

 Select Main Settings > Operation Settings > Function Reserve

The sensitivity levels (e.g., high function reserve for stable operation, medium function reserve            
and low function reserve) are configured ex works with “high function reserve for stable             
operation”. The “low function reserve” configuration enables the detection of partially transparent           
objects.

Level 0 Level 1 Level 2 Description 

Main Settings

Commands Teach Reset Factory settings

Operation Settings

Filter depth

Beam mode

Function reserve High Medium Low
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8.5 Extended configurations on the receiver control panel menu

8.5.1 Define digital inputs/outputs
The digital IO configurations (IO Pin 2, IO Pin 5 and IO Pin 6) are used to configure the parameters for the 
switching outputs:

• IO function: trigger input, teach input, command output, warning output, trigger output or validation 
output

• Inversion
• Area logic
• Start beam
• End beam

The structure of these configurations in the receiver control panel menu is as follows (multiple configura-
tions displayed simultaneously):

Examples

Configuration of pin 2 as PNP switching output
The following example shows a configuration of pin 2 as PNP switching output with additional configura-
tions, such as area logic “OR” with a beam area of 1 … 32 and beam 1 as start beam according to the 
following table.

The adjustment options Nominal value, Transmitting power and Receiver sensitivity have no           
function in the function reserve modes High, Medium, Low and Transparent. These settings are             
only effective when configuring the function reserve modes Target function reserve and Tx/            
Rx power.

It is not mandatory that extended configurations be performed on the receiver control panel menu              
in order to start up a light curtain.

The individual configuration steps for the extended configuration combinations are not described           
separately.

When configuring start and end beam, you can configure values of up to 1774. Values above               
1774 (to 1999) are not accepted and must be entered again.

OR

Start beam 1

End beam 32

Switch-on condition 1 beam interrupted

Switch-off condition 0 beams interrupted

Level 0 Level 1 Level 2 Description 

Digital IOs

IO Logic Positive PNP Negative NPN

IO Pin 2

IO Function Trigger In Teach In Area Out Warn Out Trigger Out

Inversion Normal Inverted

Teach height Execute Exit

Area logic AND OR
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 Select Digital IOs > IO Logic > Positive PNP.
 Select Digital IOs > IO Pin 2 > IO Function > Area Output.
 Select Digital IOs > IO Pin 2 > Inversion > Inverted.
 Select Digital IOs > IO Pin 2 > Area logic > OR.
 Select Digital IOs > IO Pin 2 > Start Beam > 001.
 Select Digital IOs > IO Pin 2 > End Beam > 032.

Configuration of pin 2 as PNP warning output
The following example shows the configuration of pin 2 as PNP warning output.

 Select Digital IOs > IO Logic > Positive PNP.
 Select Digital IOs > IO Pin 2 > IO Function > Warn Out.

Configuration of pin 2 as PNP trigger input
The following example shows the configuration of pin 2 as PNP trigger input.

 Select Digital IOs > IO Logic > Positive PNP.
 Select Digital IOs > IO Pin 2 > IO Function > Trigger input.

A teach input is configured according to the same principle.

Start Beam 001

End Beam 032

Level 0 Level 1 Level 2 Description 

Digital IOs

IO Logic Positive PNP Negative NPN

IO Pin 2

IO Function Trigger In Teach In Area Out Warn Out Trigger Out

Inversion Normal Inverted

Teach height Execute Exit

Area logic AND OR

Start beam (enter value)

End beam (enter value)

Level 0 Level 1 Level 2 Description 

Digital IOs

IO Logic Positive PNP Negative NPN

IO Pin 2

IO Function Trigger In Teach In Area Out Warn Out Trigger Out

Inversion Normal Inverted

Teach height Execute Exit

Area logic AND OR

Start beam (enter value)

End beam (enter value)

Trigger input and output are only active if cascading (triggered operation) was activated via the              
configuration interface or process interface.

Level 0 Level 1 Level 2 Description 
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 Select Digital IOs > IO Logic > Positive PNP.
 Select Digital IOs > IO Pin 2 > IO Function > Teach Input.

Configuration of pin 5 as PNP height area
The following example shows the configuration of pin 5 as PNP height area.

 Select Digital IOs > IO Logic > Positive PNP.
 Select Digital IOs > IO pin 5 > Teach height > Execute.

8.5.2 Inversion of the switching behavior (light/dark switching)
Light/dark switching is configured with this configuration.

The following example shows how the switching output is switched from light switching (normal) to dark 
switching (inverted).
The structure of the configuration in the receiver control panel menu is as follows:

Level 0 Level 1 Level 2 Description 

Digital IOs

IO Logic Positive PNP Negative NPN

IO Pin 5

IO function Trigger In Teach In Area Out Warn Out Trigger Out

Inversion Normal Inverted

Teach height Execute Exit

Area logic AND OR

Start beam (enter value)

End beam (enter value)

The pin is automatically configured as an area output.

 IO Function > Area Out must also be selected.

For all digital process interfaces, the configuration can also be performed via the respective field-              
bus interface (see chapter 9 et seq.) or via the Sensor Studio configuration software (see              
chapter 12).

Level 0 Level 1 Level 2 Description 

Digital IOs

IO Logic Positive PNP Negative NPN

IO Pin 2

IO function Trigger In Teach In Area Out Warn Out Trigger Out

Inversion Normal Inverted

Teach height Execute Exit

Area logic AND OR

Start beam (enter value)

End beam (enter value)

Level 0 Level 1 Level 2 Description 

Digital IOs

IO Logic Positive PNP Negative NPN

IO Pin 2
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 Select Digital IOs > IO Pin 2 > Inversion > Inverted.

8.5.3 Defining the filter depth
The filter depth is used to specify that an evaluation and output of the measurement values occurs only 
once the beam states are stable over multiple measurement cycles.
Example: with a filter depth of “5”, five measurement cycles must be consistent before an evaluation is 
performed. For further information, see also the description of interference suppression (see 
chapter 4.12).

The structure of the configuration in the receiver control panel menu is as follows:

 Select Main Settings > Operation Settings > Filter Depth.

8.5.4 Defining the display properties
With these configurations for the display, the brightness and a time unit for darkening the display are 
defined.

Visibility: 
• Off: No display; the display remains dark until a button is pressed.
• Dark: Text is only slightly visible.
• Normal: Text is visible with good contrast.
• Bright: Text appears very bright.
• Dynamic: The display darkens gradually over the number of seconds configured under Time Unit (s). 

During this time span, the display passes through all levels, from bright to off.

IO function Trigger In Teach In Area Out Warn Out Trigger Out Validation Out

Inversion Normal Inverted

Teach 
height

Execute Exit

Area logic AND OR

Start beam (enter value)

End beam (enter value)

Level 0 Level 1 Level 2 Description 

For all digital process interfaces, the configuration can also be performed via the respective field-              
bus interface (see chapter 9 et seq.) or via the Sensor Studio configuration software (see              
chapter 12).

When configuring the filter depth, you can enter values of up to 255. Values above 255 (to 299)                 
are not accepted and must be entered again.

Level 0 Level 1 Level 2 Description 

Main Settings

Commands Teach Reset Factory settings

Operation settings

Filter Depth (enter value)
min = 1
max = 255
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The structure of these configurations in the receiver control panel menu is as follows:

 Select Display > Visibility.
 Select Display > Time Unit (s).

8.5.5 Changing the language
The system language can be configured with this configuration.
The structure of the configuration in the receiver control panel menu is as follows:

 Select Display > Language.

8.5.6 Product information
With this configuration, you can read out product data (part number, type designation and other produc-
tion-specific data) of the light curtain.
The structure of the configuration in the receiver control panel menu is as follows:

 Select Information.

After approx. 5 minutes without button actuation, configuration mode is exited and the display             
changes to the previous mode. 

When configuring the Visibility in the dark, normal and bright modes, the display is completely              
inverted after approx. 15 minutes to prevent the LEDs from burning in.

When configuring the Time Unit (s), you can enter values of up to 240 seconds. Values above                
240 (to 299) are not accepted and must be entered again.

Level 0 Level 1 Level 2 Description 

Display

Language English German French Italian Spanish

Operating 
mode

Process mode Alignment

Visibility Off Dark Normal Bright Dynamic

Time Unit (s) (enter value)
min = 1
max = 240

Level 0 Level 1 Level 2 Description 

Display

Language English German French Italian Spanish

Level 0 Level 1 Level 2 Description 

Information

Product name CML 720i

Product ID Receiver Part No. (e.g., 50119835)

Serial number Receiver serial no. (e.g., 01436000288)

Transmitter ID Transmitter Part No. (e.g., 50119407)

Transmitter SN Transmitter Serial No. (e.g., 01436000289)

FW Version e.g., 01.61

HW Version e.g., A001

Kx Version e.g., P01.30e
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8.5.7 Reset to factory settings
Factory settings can be restored with this configuration.
The structure of this menu item in the receiver control panel menu is as follows:

 Select Main Settings > Command > Factory Settings.

Level 0 Level 1 Level 2 Description 

Main Settings

Commands Teach Reset Factory Settings
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9 Starting up the device - IO-Link interface
The configuration of an IO-Link interface involves the following steps on the receiver control panel and the 
IO-Link master module of the control-specific configuration software.

General prerequisites:
• The measuring light curtain has been mounted (see chapter 6) and connected (see chapter 7) cor-

rectly.
• The basic configuration has been performed (see chapter 8).

9.1 Defining IO-Link device configurations on the receiver control panel
The parameters for the IO-Link interface are configured with the bit rate and process data length (PD 
length) configurations. By changing the bit rate and/or the process data length, the light curtain receives a 
new IO-Link device ID and must be operated with the compatible IO Device Description (IODD).

The structure of these configurations in the receiver control panel menu is as follows:

 Select Main Settings > IO-Link > Bit rate.
 Select Main Settings > IO-Link > PD Length.
The bit rate and PD length are configured.
Other possible configuration steps are performed via the Sensor Studio configuration software (see 
chapter 12).
Process mode is configured via the IO-Link master module of the control-specific software.

9.2 Defining configurations via the IO-Link master module of the PLC-specific software

General prerequisites:
• The measuring light curtain has been mounted (see chapter 6) and connected (see chapter 7) cor-

rectly.
• The basic configuration has been performed (see chapter 8).
• IO-Link-specific basic configurations have been performed.

• IO-Link bit rate selected
• IO-Link PD-length selected

NOTICE
Changes take effect immediately!
 The changes take effect immediately (without restarting).
 The IODD file is supplied with the device and is available for download at www.leuze.com.

Factory settings:

Bit rate (COM2) = 38.4 kbit/s

PD length: 2 bytes

Level 0 Level 1 Level 2 Description 

Main Settings

Commands    

Operation settings

IO-Link Bit rate COM3: 230.4 COM2: 38.4

PD Length 2 bytes 8 bytes 32 bytes

Data Storage Deactivated
Activated
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 Open the configuration software of the IO-Link master module.
 Configure the following parameters:

- Beam mode (parallel-, diagonal-, crossed-beam)
- Blanking settings
- Teach settings

 Perform a teach. This is possible via the receiver control panel or the control group in the IO-Link pro-
cess data (IO-Link object 2).

 If necessary, configure additional parameter/process data (see chapter 9.3).
 Save the configuration via the control group in the IO-Link process data (IO-Link object 2).
The IO-Link-specific configurations are performed and copied to the device. The device is prepared for 
process mode.

9.3 Parameter/process data for IO-Link
The parameter data and process data are described in the IO-Link Device Description (IODD) file.
Details on the parameters and on the structure of the process data can be found in the .html document, 
which is contained in the IODD zip file, and on the Internet at www.leuze.com. 

Overview

The IO Device Description (IODD) can be used both with connected light curtain for direct con-               
figuration or without connected light curtain for creating device configurations.

The IODD files are supplied with the product. The IODD can also be downloaded from the Inter-                
net at www.leuze.com.

Sub-index access is not supported.

Group Group name

Group 1 System commands (see page 69)

Group 2 CML 700i status information (see page 69)

Group 3 Device description (see page 70)

Group 4 General configurations (see page 71)

Group 5 Extended settings (see page 72)

Group 6 Process data settings (see page 72)

Group 7 Cascading/trigger settings (see page 73)

Group 8 Blanking settings (see page 74)

Group 9 Teach settings (see page 75)

Group 10 Digital IO pin N settings (N = 2, 5, 6, 7) (see page 76)

Group 11 Time module settings for digital outputs (see page 77)

Group 12 Analog device settings (see page 78)
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System commands (group 1)

CML 700i status information (group 2)

Group 13 Autosplitting (see page 79)

Group 14 Configuration for block evaluation of beam areas (see page 79)

Group 15 Evaluation functions (see page 81)

Group Group name

The system commands trigger a direct action in the device.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

System command 2 unsigned 8 WO 128, 130, 162, 
163

128: Reset device
130: Factory reset
162: Perform teach
163: Save settings
Note:
Processing of the Save command takes up to 
600 ms. During this time, no other data/telegrams 
are accepted.

The status information consists of operating state information or error messages.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

CML 700i status informa-
tion

0 unsigned 16 RO Bits 0 … 11: measurement cycle number of a 
measurement; 
Bits 12 … 13: reserved; 
Bit 14: 1 = event (is set if the status changes)
Cause/reason for event can be seen in 
index 2162.
Bit 15: 1 = valid measurement result exists

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Teach status 69 0 unsigned 8 RO 0, 1, 128 0 Status information on teach event
0: Teach ok
1: Teach busy
128: Teach error

Alignment 70 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

RO Information on the signal level of the first and last 
beam. The value changes depending on the 
selected function reserve.

Signal level of last beam 70 1
(bit 
offset 
= 16)

unsigned 16 RO 0

Signal level of first beam 70 2
(bit 
offset 
= 0)

unsigned 16 RO 0
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Device description (group 3)

The device description specifies the device characteristics, e.g., beam spacing, the number of            
physical/logical individual beams, the number of cascades (16 individual beams) in the device            
and the cycle time.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Manufacturer name 16 0 string 
32 Octets

RO Leuze electronic GmbH + Co. KG

Manufacturer text 17 0 string 
64 Octets

RO Leuze electronic - the sensor people

Product name 18 0 string 
64 Octets

RO Receiver type designation

Product ID 19 0 string 
20 Octets

RO Receiver order number (8-digit)

Product text 20 0 string 
64 Octets

RO “Measuring light curtain CML 720i”

Serial number 
Receiver

21 0 string 
16 Octets

RO Receiver serial number for unique product identifi-
cation

Hardware version 22 0 string 
20 Octets

RO

Firmware version 23 0 string 
20 Octets

RO

User-specific name 24 0 string 
32 Octets

RW *** Device designation defined by the user

Device status 36 0 unsigned 8 RO 0 … 4 Value: 0 device is OK
Value: 1 maintenance required
Value: 2 outside of specifications
Value: 3 function test
Value: 4 error

Receiver part no. 64 0 string 
20 Octets

RO Receiver order number (8-digit)

Transmitter product des-
ignation

65 0 string 
64 Octets

RO Type designation

Transmitter part no. 66 0 string 
20 Octets

RO Transmitter order number (8-digit)

Transmitter serial num-
ber

67 0 string 
16 Octets

RO Transmitter serial number for unique product iden-
tification

Device characteristics 68 0 record 80 bit, 
isolated 
access to 
sub-index not 
possible

RO The device characteristics specify the beam spac-
ing, the number of physical/logical individual 
beams, the number of cascades (16 individual 
beams) in the device and the cycle time.

Beam spacing 68 1
(bit 
offset 
= 64)

unsigned 16 RO 5, 10, 20, 40 5 Distance between two adjacent optical individual 
beams.

Number of physical indi-
vidual beams

68 2
(bit 
offset 
= 48)

unsigned 16 RO 16

Number of configured 
logical individual beams

68 3
(bit 
offset 
= 32)

unsigned 16 RO 16 The number of logical individual beams is depen-
dent on the selected operating mode.
The evaluation functions of the CML 700i are cal-
culated on the basis of the logical individual 
beams.

Segment number of a 
beam-stream with 16 
beams

68 4
(bit 
offset 
= 16)

unsigned 16 RO 1 The CML 700i has a modular structure. 16 or 32 
individual beams are always grouped into a cas-
cade.
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General configurations (group 4)

Device cycle time 68 5
(bit 
offset 
= 0)

unsigned 16 RO 1000 The device cycle time defines the duration of a 
measurement cycle of the CML 700i.

Device model 90 0 unsigned 32 RW 1 … 6 1 Interfaces:
1: Reserved
2: Analog device with 2x inputs/outputs
3: IO-Link device with 4x inputs/outputs
5: PROFIBUS device with 2x inputs/outputs
6: RS 485 Modbus device with 2x inputs/outputs
7: PROFINET device with 2x inputs/outputs

CANopen settings 91 0 record 16 bit, 
isolated 
access to 
sub-index not 
possible

CANopen settings allow setting of Node-ID and Bit 
rate.

CANopen bit rate 91 1 (bit 
offset 
= 8)

unsigned 8 0 … 3 0 0: 1000 kbit/s
1: 500 kbit/s
2: 250 kbit/s
3: 125 kbit/s

CANopen node ID 91 2 (bit 
offset 
= 0)

unsigned 8 RW 1 … 127 10

PROFIBUS settings 92 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

PROFIBUS settings: bus address, bit rate

PROFIBUS bit rate 92 1 (bit 
offset 
= 8)

unsigned 8 0 … 3 6 0: 9.6 kbit/s
1: 19.2 kbit/s
2: 45.45 kbit/s
3: 93.75 kbit/s
4: 187.5 kbit/s
5: 500 kbit/s
6: 1500 kbit/s
7: 3000 kbit/s

Bus address 92 2 (bit 
offset 
= 8)

unsigned 8 RW 1 … 126 126

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Configured under group 4 “General configurations” are the type of scanning (parallel-/diagonal-           
/crossed-beam), counting direction and minimum object diameter for the evaluation (smoothing).          
The minimum hole size for the evaluation, e.g., with web material, is configured via inverted              
smoothing.
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Extended settings (group 5)

Process data settings (group 6)

The process data setting permits the serial output of the individual pieces of beam data. Each individual 
beam can be processed and transferred as a bit independent of measurement field length, resolution and 
beam mode.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

General settings 71 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

RW

Beam mode 71 1
(bit 
offset 
= 24)

unsigned 8 RW 0 … 2 0 0: Parallel-beam scanning
1: Diagonal-beam scanning
2: Crossed-beam scanning

Counting direction 71 2
(bit 
offset 
= 16)

unsigned 8 RW 0 … 1 0 0: Normal - starting at the connector side
1: Inverted – beginning opposite the connection 
side

Smoothing 71 3
(bit 
offset 
= 8)

unsigned 8 RW 1 … 255 1 Smoothing:
Less than i interrupted beams are ignored.

Inverted smoothing 71 4
(bit 
offset 
= 0)

unsigned 8 RW 1 … 255 1 Inverted smoothing:
Less than i free beams are ignored.

The extended settings specify the filter depth, integration time (hold function) and key lock on the               
receiver control panel.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Extended settings 74 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

RW

Filter depth 74 2
(bit 
offset 
= 16)

unsigned 8 RW 1 … 255 1 The filter depth indicates the necessary number of 
consistent beam states before the evaluation of 
the measurement values. The filter depth corre-
sponds to the number of passes with interrupted 
beam so that the result leads to switching.

Integration time 74 3
(bit 
offset 
= 0)

unsigned 8 RW 0 … 65535 0 All measurement values are accumulated and 
retained over the duration of the integration time.
Hold function in ms.

Key lock and display 78 0 unsigned 8 RW 0 … 1 0 Lock operational controls on the device.
0: Enabled
1: Locked

The process data settings describe the cyclically transmitted process data.



Starting up the device - IO-Link interface

Leuze electronic GmbH + Co. KG CML 720i Ex 73

Examples for the limitation of the measurement field length:
• Resolution of 5 mm: Measurement field length up to 1280 mm
• Resolution of 10 mm: Measurement field length up to 2560 mm
• Resolution of 20 mm, 40 mm: No limitation of the measurement field length

Cascading/trigger settings (group 7)

NOTICE
A maximum of 256 beams can be processed as a bit!
 The IO-Link specification only permits 32 bytes as process data; i.e., up to 256 beams can each be 

processed and transmitted as a bit.
 Through the limitation of the process data length, the beams, depending on the resolution, can only 

be processed and transmitted up to a certain measurement field length as a bit.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Process data settings 72 0 record 
128 bit, iso-
lated access 
to sub-index 
not possible

RW

Evaluation function 
module 01

72
(bit 
offset 
= 120)

1 unsigned 8 RW 1 … 111,
0, 
200 … 205,
208 … 210,
212

202 1 … 111: Number of optical cascades for beam-
stream evaluation (16 beams)
0: No evaluation (NOP)
200: First interrupted beam (FIB)
201: First not interrupted beam (FNIB) 
202: Last interrupted beam (LIB)
203: Last not interrupted beam (LNIB)
204: Total of interrupted beams (TIB)
205: Total of not interrupted beams (TNIB)
208: Switching state of areas 16 … 1
209: Switching state of areas 32 … 17
210: Switching state of the outputs mapped to the 
areas
212: CML 700i status information

Evaluation function 
module 02

72
(bit 
offset 
= 112)

2 unsigned 8 RW 1 … 111,
0, 
200 … 205,
208 … 210,
212

0 1 … 111: Number of optical cascades for beam-
stream evaluation (16 beams)
0: No evaluation (NOP)
200: First interrupted beam (FIB)
201: First not interrupted beam (FNIB) 
202: Last interrupted beam (LIB)
203: Last not interrupted beam (LNIB)
204: Total of interrupted beams (TIB)
205: Total of not interrupted beams (TNIB)
208: Switching state of areas 16 … 1
209: Switching state of areas 32 … 17
210: Switching state of the outputs mapped to the 
areas
212: CML 700i status information

...... .... .... .. .. .. .......

...... .... .... .. .. .. .......

Evaluation function 
module 16

72
(bit 
offset 
= 0)

1 unsigned 8 RW 1 … 111,
0, 
200 … 205,
208 … 210,
212

0 1 … 111: Number of optical cascades for beam-
stream evaluation (16 beams)
0: No evaluation (NOP)
200: First interrupted beam (FIB)
201: First not interrupted beam (FNIB)
202: Last interrupted beam (LIB)
203: Last not interrupted beam (LNIB)
204: Total of interrupted beams (TIB)
205: Total of not interrupted beams (TNIB)
208: Switching state of areas 16 … 1
209: Switching state of areas 32 … 17
210: Switching state of the outputs mapped to the 
areas
212: CML 700i status information

To prevent mutual interference, multiple light curtains can be operated with a time offset with              
respect to one another (cascade). Here, the master generates the cyclical trigger signal; the             
slaves start their measurement after delay times, which are to be set to different values.
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Blanking settings (group 8)

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Trigger Settings 73 0 record 64 bit, 
isolated 
access to 
sub-index not 
possible

RW

Cascading 73 1
(bit 
offset 
= 56)

unsigned 8 RW 0 … 1 0 0: Not active (continuous scanning)
1: Active (sensor expects trigger signal)

Function type 73 2
(bit 
offset 
= 48)

unsigned 8 RW 0 … 1 0 0: Slave (expects trigger signal)
1: Master (sends trigger signal)

Trigger delay time →
Start measurement

73 3
(bit 
offset 
= 32)

unsigned 16 RW 500 … 65535 500 Unit: µs

Pulse width 73 4 (bit 
offset 
= 16)

unsigned_16 RW 100 … 65535 100 Unit: µs

Master cycle time 73 5
(bit 
offset 
= 0)

unsigned 16 RW 1 … 6500 1 Unit: ms

Up to 4 beam areas can be deactivated. Deactivated beams can be assigned the logical              
values 0, 1 or the value of the adjacent beam. With auto blanking activated, up to 4 beam areas                  
are automatically suppressed during teaching.

Auto blanking should only be activated during commissioning of the light curtain to suppress             
interfering objects. In process mode, auto blanking should be deactivated.

For details on this topic see chapter 11.4.

NOTICE
Perform teach after changing the blanking configuration!
  Perform a teach after changing the blanking configuration.

A teach can be performed via the receiver control panel or via the teach command.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Blanking settings 76 0 record 
208 bit, iso-
lated access 
to sub-index 
not possible

RW

Number of auto blanking 
areas

76 1
(bit 
offset 
= 200)

unsigned 8 RW 0 … 4 0 Permissible number of auto blanking areas
0: 0 auto blanking areas
1: 1 auto blanking area
2: 2 auto blanking areas
3: 3 auto blanking areas
4: 4 auto blanking areas

Auto blanking (during 
teaching)

76 2
(bit 
offset 
= 192)

unsigned 8 RW 0 … 1 0 0: Not active (manual blanking area configuration)
1: Active (automatic area configuration through 
teach)
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Teach settings (group 9)

Logical value for blanking 
area 1

76 3
(bit 
offset 
= 176)

unsigned 16 RW 0 … 4 0 0: No beams blanked
1: Logical value 0 for blanked beams
2: Logical value 1 for blanked beams
3: Logical value = same as adjacent beam with 
lower beam number
4: Logical value = same as adjacent beam with 
higher beam number

Start beam of blanking 
area 1

76 4
(bit 
offset 
= 160)

unsigned 16 RW 1 … 1774 1

End beam of blanking 
area 1

76 5
(Bit 
offset 
= 144)

unsigned 16 RW 1 … 1774 1

Logical value for blanking 
area 2

76 6
(bit 
offset 
= 128)

unsigned 16 RW 0 … 4 0 0: No beams blanked
1: Logical value 0 for blanked beams
2: Logical value 1 for blanked beams
3: Logical value = same as adjacent beam with 
lower beam number
4: Logical value = same as adjacent beam with 
higher beam number

Start beam of blanking 
area 2

76 7
(bit 
offset 
= 112)

unsigned 16 RW 1 … 1774 1

End beam of blanking 
area 2

76 8
(bit 
offset 
= 96)

unsigned 16 RW 1 … 1774 1

...... .... .... .. .. .. .......

...... .... .... .. .. .. .......

Logical value for blanking 
area 4

76 12
(bit 
offset 
= 32)

unsigned 16 RW 0 … 4 0 0: No beams blanked
1: Logical value 0 for blanked beams
2: Logical value 1 for blanked beams
3: Logical value = same as adjacent beam with 
lower beam number
4: Logical value = same as adjacent beam with 
higher beam number

Start beam of blanking 
area 4

76 13
(bit 
offset 
= 16)

unsigned 16 RW 1 … 1774 1

End beam of blanking 
area 4

76 14
(bit 
offset 
= 0)

unsigned 16 RW 1 … 1774 1

Parameter Index Sub-
index

Data type Access Value range Default Explanation

In most applications, it is recommended that teach values be stored in non-volatile memory             
(remanent).

Depending on the function reserve selected for the teach event, the sensitivity is higher or lower               
(high function reserve = low sensitivity; low function reserve = high sensitivity).
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Digital IO pin N settings (N = 2, 5, 6, 7) (group 10)

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Teach settings 79 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

RW

Type of storage for teach 
values

79 2
(bit 
offset 
= 16)

unsigned 8 RW 0 … 1 0 0: Non-volatile storage of teach values
1: Teach values only saved while voltage ON

Sensitivity adjustment for 
teach event

79 3
(bit 
offset 
= 8)

unsigned 8 RW 0 … 2 0 Sensitivity of the measurement system:
0: High function reserve (for stable operation)
1: Medium function reserve
2: Low function reserve

In this group, the inputs/outputs can be set to positive switching (PNP) or to negative switching               
(NPN). The switching behavior applies the same for all inputs/outputs.

Moreover, the inputs/outputs can be configured via this group: pin 2, 5, 6, 7 for IO-Link devices,                
pin 2, 5 for analog or fieldbus devices.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Switching level of the 
inputs/outputs

77 0 unsigned 8 RW 0 … 1 1 0: Transistor, NPN
1: Transistor, PNP

Configuration of pin 2

Digital IO Pin 2 Settings 80 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

RW

Input/output selection 80 1
(bit 
offset 
= 24)

unsigned 8 RW 0 … 1 0 0: Output
1: Input

Switching behavior 80 2
(bit 
offset 
= 16)

unsigned 8 RW 0 … 1 0 0: Normal - light switching
1: Inverted - dark switching

Input function 80 3
(bit 
offset 
= 8)

unsigned 8 RW 0 … 2 0 0: Not active
1: Trigger input
2: Teach input

Output function 80 4
(bit 
offset 
= 0)

unsigned 8 RW 0 … 3 0 0: Not active
1: Switching output (area 1 … 32)
2: Warning output
3: Trigger output

 

Configuration pin 7

Digital IO Pin 7 Settings 83 0 record 32 bit, 
isolated 
access to 
sub-index not 
possible

RW

Input/output selection 83 1
(bit 
offset 
= 24)

unsigned 8 RW 0 … 1 0 0: Output
1: Input
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Settings for digital switching outputs (group 11)

Switching behavior 83 2
(bit 
offset 
= 16)

unsigned 8 RW 0 … 1 0 0: Normal - light switching
1: Inverted - dark switching

Input function 83 3
(bit 
offset 
= 8)

unsigned 8 RW 0 … 2 0 0: Not active
1: Trigger input
2: Teach input

Output function 83 4
(bit 
offset 
= 0)

unsigned 8 RW 0 … 3 0 0: Not active
1: Switching output (area 1 … 32)
2: Warning output
3: Trigger output

Parameter Index Sub-
index

Data type Access Value range Default Explanation

In this group, the beam areas can be mapped to the switching outputs and assigned a time func-                 
tion.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Configuration of pin 2

Configuration of switch-
ing output pin 2

84 0 record 56 bit, 
isolated 
access to 
sub-index not 
possible

RW Four different time functions can be set. Max. 
adjustable time period is 65 sec. Output has to be 
assigned to a beam area 1 … 32.

Operating mode of time 
module

84 1
(bit 
offset 
= 48)

unsigned 8 RW 0 … 4 0 0: Not active
1: Start-up delay
2: Switch-off delay
3: Pulse stretching
4: Pulse suppression

Time constant for 
selected function

84 2
(bit 
offset 
= 32)

unsigned 8 RW 0 … 65,000 0 Unit: ms

Area mapping 32 … 25 84 3
(bit 
offset 
= 24)

unsigned 8 RW 0b000
00000

Area mapping 24 … 17 84 4 (bit 
offset 
= 16)

unsigned 8 RW 0b000
00000

Area mapping 16 … 9 84 5 
(bit 
offset 
= 8)

unsigned 8 RW 0b000
00000

Area mapping 8 … 1 84 6
(bit 
offset 
= 0)

unsigned 8 RW 0b000
00001

...... .... .... .. .. .. .......

...... .... .... .. .. .. .......

Configuration pin 7

Digital Output Pin 7 Set-
tings

87 0 record 56 bit, 
isolated 
access to 
sub-index not 
possible

RW Four different time functions can be set. Max. 
adjustable time period is 65 sec. Output has to be 
assigned to a beam area 1 … 32.

Operating mode of time 
module

87 1
(bit 
offset 
= 48)

unsigned 8 RW 0 … 4 0 0: Not active
1: Start-up delay
2: Switch-off delay
3: Pulse stretching
4: Pulse suppression
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Analog device settings (group 12)

Time constant for 
selected function

87 2
(bit 
offset 
= 32)

unsigned 16 RW 0 … 65,000 8 Unit: ms

Area mapping 32 … 25 87 3
(bit 
offset 
= 24)

unsigned 8 RW 0b000
00000

Area mapping 24 … 17 87 4 (bit 
offset 
= 16)

unsigned 8 RW 0b000
00000

Area mapping 16 … 9 87 5 
(bit 
offset 
= 8)

unsigned 8 RW 0b000
00000

Area mapping 8 … 1 87 6
(bit 
offset 
= 0)

unsigned 8 RW 0b000
00001

Parameter Index Sub-
index

Data type Access Value range Default Explanation

In this group, various parameters can be used to set the analog device configurations, e.g, the               
configuration of the analog output level and how the evaluation function that is represented on              
the analog output is selected.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Signal level 88 0 unsigned 8 RW 0 … 6 0 Configuration of the analog output level: voltage: 
0 … 5 V voltage: 0 … 10 V voltage: 0 … 11 V cur-
rent: 4 … 20 mA current: 0 … 20 mA current: 
0 … 24 mA
0: Not active
1: Voltage: 0 … 5 V
2: Voltage: 0 … 10 V
3: Voltage: 0 … 11 V
4: Current: 4 … 20 mA
5: Current: 0 … 20 mA
6: Current: 0 … 24 mA

Evaluation function 89 0 record 48 bit, 
isolated 
access to 
sub-index not 
possible

RW Selection of the evaluation function that is repre-
sented on the analog output: first interrupted/not 
interrupted beam (FIB/FNIB), last interrupted/not 
interrupted beam (LIB/LNIB), total of interrupted/
not interrupted beams (TIB/TNIB)

Analog Function 89 1
(bit 
offset 
= 40)

unsigned 8 RW 0 … 6 0 0: No evaluation (NOP)
1: First interrupted beam (FIB)
2: First not interrupted beam (FNIB)
3: Last interrupted beam (LIB)
4: Last not interrupted beam (LNIB)
5: Total of interrupted beams (TIB)
6: Total of not interrupted beams (TNIB)

Start beam of analog 
measuring area 

89 2
(bit 
offset 
= 16)

unsigned 16 RW 1 … 1774 1

End beam of analog 
measuring area

89 3
(bit 
offset 
= 16)

unsigned 16 RW 1 … 1774 1
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Autosplitting (group 13)

Configuration for block evaluation of beam areas (group 14)

In this group, it is possible to split all logical beams into areas of identical size. The fields of areas                   
01 … 32 are thereby automatically configured.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Auto-Splitting 98 0 unsigned 1
6

WO 1 … 32
1: (active: all 
beams free - not 
active: = one 
beam inter-
rupted)

257 … 288
2: (active: one 
beam free - not 
active: = all 
beams inter-
rupted)

1: 
(active
: all 
beams 
free - 
not 
active: 
= one 
beam 
inter-
rupted)

Splitting of all logical beams into areas of identical 
size according to the number of areas set under 
“Number of areas”. The fields of areas 01 … 32 
are thereby automatically configured.

1: (active: all beams free – 
not active: ≥  one beam interrupted)
1: One area
…
32: Thirty-two areas

2: (active: one beam free – 
not active: = all beams interrupted)
257: One area
…
288: Thirty-two areas

Evaluation of the beams 
in the area

98 1
(bit 
offset 
= 8)

unsigned 8 WO 0 … 1 0 0: OR combined
1: AND combined

Number of Areas (equi-
distant partitioning)

98 2
(bit 
offset 
= 0)

unsigned 8 WO 1 … 32 1

In this group, a detailed area configuration can be displayed and a beam area configured for the                
block evaluation.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

Show detailed area con-
figuration

99 0 unsigned 8 RW 0 … 32 0 Choose the area (1..32) that requires detailed con-
figuration.
0: Area 01
1: Area 02
2: Area 03
…
31: Area 32

Configuration of area 1

Configuration of area 01 100 0 record 
112 bit

RW Configuration of the area: definition of the status 
conditions so that the area takes on a logical 
1 or 0. For diagonal- or crossed-beam scanning, 
the numbers of the logical beams are to be 
entered.

Area 100 1
(bit 
offset 
= 104)

unsigned 8 RW 0 … 1 0 0: Not active
1: Active

Active beam 100 2
(bit 
offset 
= 96)

unsigned 8 RW 0 … 1 0 0: Light switching (beam is active if light path is 
free)
1: Dark switching (beam is active if light path is 
interrupted)

Start beam of area 100 3
(bit 
offset 
= 80)

unsigned 16 RW 65534
65533
65532
65531
65530

1
65534: First interrupted beam (FIB)
65533: First not interrupted beam (FNIB)
65532: Last interrupted beam (LIB)
65531: Last not interrupted beam (LNIB)
65530: Target minimum (FS)
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End beam of area 100 4
(bit 
offset 
= 64)

unsigned 16 RW 65534
65533
65532
65531
65530

1
65534: First interrupted beam (FIB)
65533: First not interrupted beam (FNIB)
65532: Last interrupted beam (LIB)
65531: Last not interrupted beam (LNIB)
65530: Target minimum (FS)

Number of active beams 
for area ON

100 5
(bit 
offset 
= 48)

unsigned 16 RW 0 … 1774 0 If more than or the same number of active beams 
are free or interrupted (see sub-index 2), the eval-
uation result of the area changes to “1”.

Number of active beams 
for area OFF

100 6
(bit 
offset 
= 32)

unsigned 16 RW 0 … 1774 0 If less than or the same number of active beams 
are free or interrupted (see sub-index 2), the eval-
uation result of the area changes to “0”.

Specified middle of the 
area

100 7
(bit 
offset 
= 16)

unsigned 16 RW 0 … 1774 0

Specified width of the 
area

100 8
(bit 
offset 
= 0)

unsigned 16 RW 0 … 1774 0

...... .... .... .. .. .. .......

...... .... .... .. .. .. .......

Configuration of area 32

Configuration of area 32 131 0 record 
112 bit

RW Configuration of the area: definition of the status 
conditions so that the area takes on a logical 
1 or 0. For diagonal- or crossed-beam scanning, 
the numbers of the logical beams are to be 
entered.

Area 131 1
(bit 
offset 
= 104)

unsigned 8 RW 0 … 1 0 0: Not active
1: Active

Active beam 131 2
(bit 
offset 
= 96)

unsigned 8 RW 0 … 1 0 0: Light switching (beam is active if light path is 
free)
1: Dark switching (beam is active if light path is 
interrupted)

Start beam of area 131 3
(bit 
offset 
= 80)

unsigned 16 RW 65534
65533
65532
65531
65530

1 65534: First interrupted beam (FIB)
65533: First not interrupted beam (FNIB)
65532: Last interrupted beam (LIB)
65531: Last not interrupted beam (LNIB)
65530: Target minimum (FS)

End beam of area 131 4
(bit 
offset 
= 64)

unsigned 16 RW 65534
65533
65532
65531
65530

1 65534: First interrupted beam (FIB)
65533: First not interrupted beam (FNIB)
65532: Last interrupted beam (LIB)
65531: Last not interrupted beam (LNIB)
65530: Target minimum (FS)

Number of active beams 
for area ON

131 5
(bit 
offset 
= 48)

unsigned 16 RW 1 … 1774 0

Number of active beams 
for area OFF

131 6
(bit 
offset 
= 32)

unsigned 16 RW 1 … 1774 0

Specified middle of the 
area

131 7
(bit 
offset 
= 16)

unsigned 16 RW 1 … 1774 0

Specified width of the 
area

131 8
(bit 
offset 
= 0)

unsigned 16 RW 1 … 1774 0

Parameter Index Sub-
index

Data type Access Value range Default Explanation
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Evaluation functions (group 15)

In this group, all evaluation functions can be configured.

Parameter Index Sub-
index

Data type Access Value range Default Explanation

First interrupted beam 
(FIB)

150 0 unsigned 16 RO Logical beam number of the first darkened individ-
ual beam. The logical beam numbers change to 
the “diagonal” or “crossed-beam” mode. Note any 
changed configuration of the counting direction!

First not interrupted 
beam (FNIB)

151 0 unsigned 16 RO Logical beam number of the first undarkened indi-
vidual beam. The logical beam numbers change to 
the “diagonal” or “crossed-beam” mode. Note any 
changed configuration of the counting direction!

Last interrupted beam 
(LIB)

152 0 unsigned 16 RO Logical beam number of the last darkened individ-
ual beam. The logical beam numbers change in 
diagonal- or crossed-beam mode. Note any 
changed configuration of the counting direction!

Last not interrupted 
beam (LNIB)

153 0 unsigned 16 RO Logical beam number of the last undarkened indi-
vidual beam. The logical beam numbers change to 
the “diagonal” or “crossed-beam” mode. Note any 
changed configuration of the counting direction!

Total of interrupted 
beams (TIB)

154 0 unsigned 16 RO Sum of all darkened individual beams. The sum 
changes to the “diagonal” or “crossed-beam” 
mode.

Total of not interrupted 
beams (TNIB)

155 0 unsigned 16 RO Sum of all undarkened individual beams. The sum 
changes to the “diagonal” or “crossed-beam” 
mode.

Area output - LoWord 158 0 unsigned 16 RO Status of areas 01 … 16 as 2 bytes of process 
data

Area output - HiWord 159 0 unsigned 16 RO Status of areas 17 … 32 as 2 bytes of process 
data

Result of the area evalu-
ation assigned to Pins

160 0 record 16 bit, 
isolated 
access to 
sub-index not 
possible

RO Logical value of the area evaluation assigned to 
the output pin

Reserved 160 1
(bit 
offset 
= 4)

unsigned 16 RO

Pin 7 160 2
(bit 
offset 
= 3)

boolean RO

Pin 6 160 3
(bit 
offset 
= 2)

boolean RO

Pin 5 160 4
(bit 
offset 
= 1)

boolean RO

Pin 2 160 5
(bit 
offset 
= 1)

boolean RO

HW analog (HWA) 161 0 unsigned 16 RO

PD beam-stream 171 0 array RO 8 bytes
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PD beam-stream 172 0 array RO 16 bytes

PD beam-stream 173 0 array RO 32 bytes

PD beam-stream 174 0 array RO 64 bytes

PD beam-stream 175 0 array RO 128 bytes

PD beam-stream 176 0 array RO 222 bytes

Beam-stream mask 177 0 array RO 222 bytes

Parameter Index Sub-
index

Data type Access Value range Default Explanation
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10 Starting up the device - CANopen interface
The configuration of a CANopen interface involves the following steps on the receiver control panel and in 
the control-specific configuration software. 

General prerequisites:
• The measuring light curtain has been mounted (see chapter 6) and connected (see chapter 7) cor-

rectly.
• The basic configuration has been performed (see chapter 8).

10.1 Defining the CANopen basic configuration on the receiver control panel
The parameters for the CANopen interface are defined with the node ID and bit rate configurations.
The structure of these configurations in the receiver control panel menu is as follows:

Prerequisites:
• The measuring light curtain must be correctly aligned (see chapter 8.1).
• The measuring light curtain must be correctly taught (see chapter 8.2).

The following procedure describes the configurations for CANopen interfaces.
 Select Main Settings > CANopen > Node ID > Enter value.
 Select Main Settings > CANopen > Bit Rate > Enter value.
The CANopen address (Node ID) and bit rate are configured.
Other possible configuration steps are performed via the Sensor Studio configuration software (see 
chapter 12).
Process mode is configured via the control-specific CANopen interface of the CANopen master.

10.2 Defining configurations via the PLC-specific software of the CANopen master

General prerequisites:
• The measuring light curtain has been mounted (see chapter 6) and connected (see chapter 7) cor-

rectly.
• The basic configuration has been performed (see chapter 8).
• The CANopen basic configurations have been performed:

• CANopen node ID selected
• CANopen bit rate selected

Specific prerequisites:
• The CANopen-specific EDS file must be installed on the control.

Level 0 Level 1 Level 2 Description

Main Settings

Commands    

Operation settings

IO-Link

CANopen Node ID (enter value)
min = 1
max = 127

Bit rate 1000 kbit/s 500 kbit/s 250 kbit/s 125 kbit/s

The CANopen device description (EDS file) can be used for direct configuration with connected             
light curtain.

An EDS file is supplied with the product. It can also be downloaded from the Internet at                
www.leuze.com.
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 Open the interface configuration software.
 Configure the following parameters:

- Operating mode (parallel-beam; diagonal-beam; crossed-beam scanning)
- Blanking settings
- Teach settings

 Perform a teach. This is possible via the receiver control panel or the control group in the CANopen pro-
cess data (CANopen object 0x2200).

 If necessary, configure additional parameter/process data (see chapter 10.3).
 Save the configuration via the control group in the CANopen process data (CANopen object 0x2200).
The CANopen-specific configurations have been performed and the CML 700i is ready for process mode.

10.3 Parameter- / process data for CANopen
The configuration parameters or process data for CANopen is defined via the following object descriptions.

NOTICE
Configuration dependent on the control-specific software!
 The sequence of the configurations is dependent on the control-specific software.
 First configure the EDS file while off-line.
 Once all parameters have been configured, transmit the EDS configurations to the CML 700i.

Information on using the configuration parameters can be found in the general descriptions of the              
individual functions of the CML 700i (see chapter 4).

NOTICE
Boundary conditions for object descriptions!
 Indices 0x1000 … 0x1FFF contain the standard communication-specific parameters used with  

CANopen.
 The product-specific parameters begin with index 0x2000.
 Communication-specific parameters are automatically persistent.
 In order for product-specific parameters to be retained following a power down/up, a save command 

(index 0x2200) is necessary.

The following abbreviations for data types apply in the following group descriptions:

t08U = type 8 bit unsigned integer

t08S = type 8 bit signed integer

t16U = type 16 bit unsigned integer

t16S = type 16 bit signed integer

The following abbreviations for max. values apply in the following group descriptions:

MAX-BEAM = maximum number of beams (max. 1774)

MAX_T08U = maximum 8 bit unsigned integer

MAX_T16U = maximum 16 bit unsigned integer

MAX_T32U = maximum 32 bit unsigned integer
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Group overview

CANopen-specific objects (group 1)

Group Group name

Group 1 CANopen-specific objects (see page 85)

Group 2 Device description (see page 86)

Group 3 General configurations (see page 87)

Group 4 Extended settings (see page 87)

Group 5 Cascading configuration (see page 88)

Group 6 Teach settings (see page 88)

Group 7 Blanking settings (see page 89)

Group 8 Switching level of inputs/outputs (see page 91)

Group 9 Area configuration (see page 92)

Group 10 Commands (see page 94)

Group 11 Teach status (see page 95)

Group 12 Check the alignment of the light curtains (see page 95)

Group 13 Process data (see page 96)

Group 14 Status (see page 97)

Parameter Index 
(hex)

Sub-
index 
(hex)

Data 
type

Access Min. 
value

Max. value Default Explanation

Device type 1000 RO 0

Error register 1001 RO

COB-ID-SYNC 1005 RW 0x000
00080

Receiver product designation 1008 CONST

Hardware version 1009 CONST

COB-ID-SYNC EMCY 1014 RW

Firmware version 100A CONST

Producer heartbeat time 1017 RW 0 Necessary for heartbeat 
mechanism

Identity object 1018 RO

Transmit PDO communication parameter 1 1800 RW PDO 1 properties

Transmit PDO communication parameter 2 1801 RW PDO 2 properties

Transmit PDO communication parameter 3 1802 RW PDO 3 properties

Transmit PDO communication parameter 4 1803 RW PDO 4 properties

.... .... .... ....

Transmit PDO communication 
parameter 28

181B RW PDO 28 properties

Transmit PDO mapping parameter 1 1A00 t32U RW Mapped objects
in PDO 1
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Standard procedure for the TPDO mapping:
 Set the device to the Preoperational state.
 In the desired TPDO Transmit PDO communication parameter 1 … 28 (objects 0x1800 … 0x181B), set 

the COB-ID (sub-index 1) to 0x80000xxx (where the xxx part is node-dependent) and transmit this 
COB-ID to the device.
This sets the invalid bit, thereby making the TPDO entry invalid.

 In the desired TPDO Transmit PDO mapping parameter 1 … 28 (objects 0x1A00 … 0x1A1B), set the 
entry for the number of the following elements (sub-index 0, numOfEntries) to 0 and transmit this to the 
device. 
An existing mapping is thereby deleted.

 Then reset this entry to the number of desired mapping elements, whereby a maximum of 4 elements 
per TPDO are possible.
Transmit this entry back to the device.

 Set the mapping entries to the desired values. Each of the mapping sub-indices contains a 32-bit value 
that is structured as follows: SDO object number, sub-index and length. Normally (depending on the 
used master), the respective settings can be selected from a list.

 After completing the mapping, transmit the complete TPDO Transmit PDO mapping parameter 1 … 28 
object to the device.

 In the TPDO Transmit PDO communication parameter 1 … 28 object (objects 0x1800 … 0x181B), set 
the transmission type (sub-index 2 Transmission type) and, if applicable, the event timer (sub-index 5, 
Event timer).

 In the same TPDO object, set the COB-ID (sub-index 1) to 0x00000xxx (where the xxx part is node-
dependent) and transmit the complete TPDO object including all sub-indices to the device. This resets 
the invalid bit, thereby making the TPDO entry valid.

 Set the device to the Operational state.
With operating mode set to Transmission type, the device starts to send process data (PDOs).

Device description (group 2)

Transmit PDO mapping parameter 2 1A01 t32U RW Mapped objects
in PDO 2

Transmit PDO mapping parameter 3 1A02 t32U RW Mapped objects
in PDO 3

Transmit PDO mapping parameter 4 1A03 t32U RW Mapped objects
in PDO 4

.... .... .... .... ....

Transmit PDO mapping parameter 28 1A1B t32U RW Mapped objects
in PDO 28

Parameter Index 
(hex)

Sub-
index 
(hex)

Data 
type

Access Min. 
value

Max. value Default Explanation

The following standard procedure for the TPDO mapping may vary depending on the used con-              
figuration software.

NOTICE
Boundary conditions for object descriptions!
 Beginning with firmware V2.16, no process data settings are automatically stored in non-volatile mem-

ory (remanent). The <Save> command is always to be used.

The device characteristics, beginning with index 0x200B, specify the beam spacing, the number            
of physical/logical individual beams, the number of cascades (16 individual beams) in the device             
and the cycle time.
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General configurations (group 3)

Extended settings (group 4)

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Manufacturer name 2000 RO Leuze electronic

Manufacturer text 2001 RO The sensor people

Receiver part no. 2002 RO Receiver

Receiver serial number 2003 RO Receiver

Transmitter product designation 2008 RO Transmitter

Transmitter part no. 2009 RO Transmitter

Transmitter serial number 200A RO Transmitter

Beam spacing 200B 1 t16U RO

Number of physical individual beams 200B 2 t16U RO

Number of configured logical cascades 200B 3 t16U RO With parallel scanning, the 
number of logical individual 
beams corresponds to the 
number of physical individual 
beams; with diagonal scan-
ning, this number is doubled.

Number of optical cascades 200B 4 t16U RO

Device cycle time [µs] 200B 5 t16U RO Duration for a complete mea-
surement cycle (measure-
ment cycle for one 
measurement); minimum time 
is 1 ms.

Configured in group 3 “General configurations” are the type of scanning (parallel-/diagonal-/           
crossed-beam), counting direction and minimum object size for the evaluation (smoothing). The           
minimum hole size for the evaluation, e.g., with web material, is configured via inverted smooth-              
ing.

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Operating mode 2100 1 t08U RW 0 2 0 0: Parallel-beam scanning
1: Diagonal-beam scanning
2: Crossed-beam scanning

Counting direction 2100 2 t08U RW 0 1 0 0: Normal – beginning at the 
connection side 
1: Inverted – beginning oppo-
site the connection side

Smoothing 2100 3 t08U RW 1 MAX_T08U 1 Less than i interrupted beams 
are ignored

Smoothing inverted 2100 4 t08U RW 1 MAX_T08U 1 Less than i free beams are 
ignored

The filter depth indicates the necessary number of consistent beam states before the evaluation             
of the measurement values.

All measurement values are accumulated and retained over the duration of the integration time.
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Cascading configuration (group 5)

Teach settings (group 6)

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

2101 1 t08U RO 0 Reserved

Filter depth 2101 2 t08U RW 0 MAX_T08U 1 The necessary number of 
consistent beam states before 
the evaluation of the mea-
surement values.

Integration/hold time 2101 3 t16U RW 0 MAX_T16U 0 Hold function in ms
All measurement values are 
accumulated and retained 
over the duration of the inte-
gration time.

Key lock and display 2106 t08U RW 0 2 0 Lock operational controls on 
the device.
0: Enabled
1: Locked
2: Volatile

To prevent mutual interference, multiple light curtains can be operated with a time offset with re-               
spect to one another (cascade). Here, the master generates the cyclical trigger signal; the slaves              
start their measurement after delay times, which are to be set to different values.

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Cascading 2102 1 t08U RW 1 0 0: Not active (continuous 
scanning)
1: Active (sensor expects trig-
ger signal)

Note: With cascading opera-
tion, the master must also be 
set to 1 (active)!

Function type 2102 2 t08U RW 1 0 0: Slave (expects trigger sig-
nal)
1: Master (sends trigger sig-
nal)

Trigger delay time → Start of the measure-
ment

2102 3 t16U RW MAX_T16U 500 Delay time in µs (from rising 
edge at TRIGGER until start 
of measurement cycle)

Reserved 2102 4 t16U

Master cycle time 2102 5 t16U RW 6500 1 Duration of a TRIGGER_cycle 
in ms

In most applications, it is recommended that the teach values be stored in non-volatile memory.

Depending on the function reserve selected for the teach event, the sensitivity is higher or lower               
(high function reserve = low sensitivity; low function reserve = high sensitivity).
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Blanking settings (group 7)

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Number of teach cycles 2103 1 t08U RO 10 Depending on the environ-
mental conditions or applica-
tion, the light curtain may 
have completed multiple 
cycles after the triggering of a 
teach.

Type of storage for teach values 2103 2 t08U RW 0 1 0 0: Non-volatile storage of 
teach values
1: Teach values only saved 
while voltage ON

Sensitivity adjustment for teach event 2103 3 t08U RW 0 Sensitivity of the measure-
ment system:
0: High function reserve (for 
stable operation)
1: Medium function reserve
2: Low function reserve

Teach status 2400 1 t08S RO 0 MAX_T08U Information about the last 
teach:
00: Teach ok
01: Teach busy
80: Teach error (bit 8 = error 
bit)

Up to 4 beam areas can be deactivated. Deactivated beams can be assigned the logical              
values 0, 1 or the value of the adjacent beam. With auto blanking activated, up to 4 beam areas                  
are automatically suppressed during teaching.

Auto blanking should only be activated during commissioning of the CML 700i to suppress inter-              
fering objects. In process mode, auto blanking should be deactivated.

For details on this topic see chapter 11.4.

NOTICE
Perform teach after changing the blanking configuration!
  Perform a teach after changing the blanking configuration.

A teach can be performed via the receiver control panel or via the teach command.



Starting up the device - CANopen interface

Leuze electronic GmbH + Co. KG CML 720i Ex 90

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Number of auto blanking areas 2104 1 t08U RW 0 4 0 Permissible number of auto 
blanking areas
0: 0 auto blanking areas
1: 1 auto blanking area
2: 2 auto blanking areas
3: 3 auto blanking areas
4: 4 auto blanking areas

Auto blanking (during teaching) 2104 2 t08U RW 0 1 0 0: Not active (manual blanking 
area configuration)
1: Active (automatic blanking 
area configuration through 
teach)

Function for blanking area 1 2104 3 t16U RW 0 4 0 0: No beams blanked, 
1: Logical value 0 for blanked 
beams, 
2: Logical value 1 for blanked 
beams, 
3: Logical value = same as 
adjacent beam with lower 
beam number,
4: Logical value = same as 
adjacent beam with higher 
beam number 

Start beam of blanking area 1 2104 4 t16U RW 1 MAX_BEAM 1 Start beam of the blanking 
area

End beam of blanking area 1 2104 5 t16U RW 1 MAX_BEAM 1 End beam of the blanking 
area

Function for blanking area 2 2104 6 t16U RW 0 4 0 0: No beams blanked, 
1: Logical value 0 for blanked 
beams, 
2: Logical value 1 for blanked 
beams, 
3: Logical value = same as 
adjacent beam with lower 
beam number,
4: Logical value = same as 
adjacent beam with higher 
beam number 

Start beam of blanking area 2 2104 7 t16U RW 1 MAX_BEAM 1 Start beam of the blanking 
area

End beam of blanking area 2 2104 8 t16U RW 1 MAX_BEAM 1 End beam of the blanking 
area

Function for blanking area 3 2104 9 t16U RW 0 4 0 0: No beams blanked, 
1: Logical value 0 for blanked 
beams, 
2: Logical value 1 for blanked 
beams, 
3: Logical value = same as 
adjacent beam with lower 
beam number,
4: Logical value = same as 
adjacent beam with higher 
beam number 

Start beam of blanking area 3 2104 A t16U RW 1 MAX_BEAM 1 Start beam of the blanking 
area

End beam of blanking area 3 2104 B t16U RW 1 MAX_BEAM 1 End beam of the blanking 
area



Starting up the device - CANopen interface

Leuze electronic GmbH + Co. KG CML 720i Ex 91

Switching level of inputs/outputs (group 8)

Function for blanking area 4 2104 C t16U RW 0 4 0 0: No beams blanked, 
1: Logical value 0 for blanked 
beams, 
2: Logical value 1 for blanked 
beams, 
3: Logical value = same as 
adjacent beam with lower 
beam number,
4: Logical value = same as 
adjacent beam with higher 
beam number 

Start beam of blanking area 4 2104 D t16U RW 1 MAX_BEAM 1 Start beam of the blanking 
area

End beam of blanking area 4 2104 E t16U RW 1 MAX_BEAM 1 End beam of the blanking 
area

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

The inputs/outputs can be set to positive switching (PNP) or to negative switching (NPN). The              
switching behavior applies the same for all inputs/outputs.

For details on this topic see chapter 11.

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Switching level of inputs/outputs 2150 Bool RW 0 1 1 0: NPN
1: PNP

Configuration of the inputs/outputs: pin 2 and/or pin 5.

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Configuration of pin 2

Pin 2:
Output function

2151 1 t08U RW 0 3 0 0: Not active
1: Switching output 
(area 1 … 32) 
2: Warning output
3: Trigger output

Pin 2:
Input function

2151 2 t08U RW 0 2 2 0: Not active
1: Trigger input
2: Teach input

Pin 2:
Switching behavior

2151 3 t08U RW 0 1 0 0: Normal - light switching
1: Inverted - dark switching

Pin 2: 
Input/output selection

2151 4 t08U RW 0 1 1 0: Output
1: Input

Configuration of pin 5

Pin 5:
Output function

2152 1 t08U RW 0 3 0 0: Not active
1: Switching output (area
 1 … 32)
2: Warning output
3: Trigger output
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Procedure for the four time ranges:
Four different time functions can be set; the maximum duration that can be set is 65 s.
Mapping of the area 1 … 32 to output pin 2 = index 0x2155 sub 3 or index 0x2156 sub 3 for pin 5.
 Activate the area by entering a 1 at the corresponding position in the 32-bit word. Area 1 … 32 increas-

ing from right.

Area configuration (group 9)

Procedure for manual area splitting of the maximum 32 areas:
 Definition of the status conditions so that the area takes on a logical 1 or 0.

For diagonal- or crossed-beam mode, the numbers of the logical beams are to be entered.

Pin 5:
Input function

2152 2 t08U RW 0 2 1 0: Not active
1: Trigger input
2: Teach input

Pin 5:
Switching behavior

2152 3 t08U RW 0 1 0 0: Normal - light switching
1: Inverted - dark switching

Pin 5: 
Input/output selection

2152 4 t08U RW 0 1 1 0: Output
1: Input

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

For details on this topic see chapter 11.

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Digital Output Pin 2 Settings

Operating mode of time module 2155 1 t08U RW 0 4 0 0: Not active
1: Start-up delay
2: Switch-off delay
3: Pulse stretching
4: Pulse suppression

Delay time for selected function 2155 2 t16U RW 0 MAX_T16U 0 0 … 65535 ms

Area mapping 32 … 1 2155 3 t32U RW 0 MAX_T32U 0 Logical OR link mask of the 
switching outputs

Digital Output Pin 5 Settings

Operating mode of time module 2156 1 t08U RW 0 4 0 0: Not active
1: Start-up delay
2: Switch-off delay
3: Pulse stretching
4: Pulse suppression

Delay time for selected function 2156 2 t16U RW 0 MAX_T16U 0 0 … 65535 ms

Area mapping 32 … 1 2156 3 t32U RW 0 MAX_T32U 0 Logical OR link mask of the 
switching outputs

For details on this topic see chapter 11.
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Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Configuration of area 1 2170

Area 2170 1 t08U RW 0 1 0 0: Not active
1: Active

Logical behavior of the area 2170 2 t08U RW 0 1 0 0: Normal - light switching
1: Inverted - dark switching

Start beam of area 2170 3 t16U RW 1 FFFE 1 1 … 1774
65534: First interrupted beam 
(FIB)
65533: First not interrupted 
beam (FNIB)
65532: Last interrupted beam 
(LIB)
65531: Last not interrupted 
beam (LNIB)

End beam of area 2170 4 t16U RW 1 FFFE 1 1 … 1774
65534: First interrupted beam 
(FIB)
65533: First not interrupted 
beam (FNIB)
65532: Last interrupted beam 
(LIB)
65531: Last not interrupted 
beam (LNIB)

Number of active beams for area ON 2170 5 t16U RW 0 MAX_BEA
M

0 0 … 1774

Number of active beams for area OFF 2170 6 t16U RW 0 MAX_BEA
M

0 0 … 1774

Specified middle of the area 2170 7 t16U RW 0 MAX_BEA
M

0 0 … 1774

Specified width of the area 2170 8 t16U RW 0 MAX_BEA
M

0 0 … 1774

Configuration of area 2 2171

Area 2171 1 t08U RW 0 1 0 0: Not active
1: Active

Logical behavior of the area 2171 2 t08U RW 0 1 0 0: Normal - light switching
1: Inverted - dark switching

Start beam of area 2171 3 t16U RW 1 FFFE 1 1 … 1774
65534: First interrupted beam 
(FIB)
65533: First not interrupted 
beam (FNIB)
65532: Last interrupted beam 
(LIB)
65531: Last not interrupted 
beam (LNIB)

End beam of area 2171 4 t16U RW 1 FFFE 1 1 … 1774
65534: First interrupted beam 
(FIB)
65533: First not interrupted 
beam (FNIB)
65532: Last interrupted beam 
(LIB)
65531: Last not interrupted 
beam (LNIB)

Number of active beams for area ON 2171 5 t16U RW 0 MAX_BEA
M

0 0 … 1774

Number of active beams for area OFF 2171 6 t16U RW 0 MAX_BEA
M

0 0 … 1774

Specified middle of the area 2171 7 t16U RW 0 MAX_BEA
M

0 0 … 1774

Specified width of the area 2171 8 t16U RW 0 MAX_BEA
M

0 0 … 1774

All other 30 areas are configured in the same way as described for 2170 and 2171:
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Commands (group 10)

Procedure for "automatic" area splitting:
 Send the desired number of areas to the command argument (index 0x2200, sub 2).
 Perform area splitting: set command argument (index 0x2200, sub 1) to value 8.

Configuration of area 3 2172

Configuration of area 4 2173

Configuration of area 5 2174

Configuration of area 6 2175

Configuration of area 7 2176

Configuration of area 8 2177

Configuration of area 9 2178

Configuration of area 10 2179

Configuration of area 11 217A

Configuration of area 12 217B

Configuration of area 13 217C

Configuration of area 14 217D

Configuration of area 15 217E

Configuration of area 16 217F

Configuration of area 17 2180

Configuration of area 18 2181

Configuration of area 19 2182

Configuration of area 20 2183

Configuration of area 21 2184

Configuration of area 22 2185

Configuration of area 23 2186

Configuration of area 24 2187

Configuration of area 25 2188

Configuration of area 26 2189

Configuration of area 27 218A

Configuration of area 28 218B

Configuration of area 29 218C

Configuration of area 30 218D

Configuration of area 31 218E

Configuration of area 32 218F

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

For all commands, first the command argument must be written and then the command identifier.
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Teach status (group 11)

Check the alignment of the light curtains (group 12)

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Command Identifier 2200 1 t16U WO Command to be executed for 
write access
0: Reserved
1: Reserved
3: Teach
4: Reboot
5: Reset
Note 
Reset deletes the user set-
tings. On the next PowerOn, 
the factory settings are 
applied. To reset to factory 
settings, a reboot must follow 
a reset.

6: Save
Note:
Processing of the Save com-
mand takes up to 600 ms. 
During this time, no other 
data/telegrams are accepted.

7: Reserved
8: Splitting, division of the 
evaluation areas

Command argument 2200 2 t16U WO Argument for command 8 
(splitting):
Into how many areas should 
the beams be split?
Number of areas 1 … i
Enter value (max. 32):
1: i = 1: All beams of the light 
curtain form one area
2: i = 2: Beams are split into 2 
equally large areas
3: i = 3: Beams are split into 3 
equally large areas, etc. 
(bit 0 … 7)

Note on splitting: 
The result of the splitting func-
tion is written in the Configu-
ration of area …  objects with 
indices 2170 … 218F.
__________________________
0: Area result active if a beam 
is interrupted (AND) 
1: Area result active if all 
beams are interrupted (OR) 
(bit 8)

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Teach status 2400 1 t08U RO MAX_T08U Information about the last 
teach event:
00: Teach ok
01: Teach busy
80: Teach error (bit 8 = error 
bit)

Information on the signal level of the first and last beam.

The value changes depending on the selected function reserve.
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Process data (group 13)

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Signal level of first beam 2404 1 t16U RO Signal level on beam no. 1

Signal level of last beam 2404 2 t16U RO Signal level on beam no. i

Configuration of the process data:

- First interrupted/not interrupted beam (FIB/FNIB),

- Last interrupted/not interrupted beam (LIB/LNIB),

- Total of interrupted/not interrupted beams (TIB/TNIB);

- Area Out 1 … 16 or 17 … 32; digital inputs/outputs

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

First interrupted beam (FIB) 2405 t16U RO First interrupted beam

First not interrupted beam (FNIB) 2406 t16U RO First not interrupted beam

Last interrupted beam (LIB) 2407 t16U RO Last interrupted beam

Last not interrupted beam (LNIB) 2408 t16U RO Last not interrupted beam 

Total of interrupted beams (TIB) 2409 t16U RO Sum of interrupted beams

Total of not interrupted beams (TNIB) 240A t16U RO Sum of not interrupted beams

Area output - LoWord 240D t16U RO Logical value of areas 1 … 16

Area output - HiWord 240E t16U RO Logical value of areas 
17 … 32

Status of the digital inputs/outputs 240F t16U RO Representation of the hard-
ware switching outputs; these 
are mapped to the areas

CML 700i status information 2411 t16U RO Bits 0 … 11: measurement 
cycle number of a measure-
ment; 
Bits 12 … 13: reserved; 
Bit 14: 1 = Event (is set if the 
status changes. As soon as 
the status is 0 again, bit 14 is 
also set to 0.)
Bit 15: 1 = valid measure-
ment result exists
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Status (group 14)

Beam-stream 2412 1 t16U RO Reading out of the beam 
states of all existing individual 
beams:
One bit per interrupted or 
uninterrupted beam in 
inverted operation (i.e., 
bit i = 1 corresponds to “light 
path is free”).
An object contains 16 individ-
ual beams, i.e., beam i to 
(i+15).
__________________________
Read out beam 1 … 16

2 t16U RO Read out beam 17 … 32

3 t16U RO Read out beam 33 … 48

... .... .. .........

6F t16U RO Read out beam 1761 … 1774

Status/state of a beam 2402 t16U RO Reading out the beams states 
according to the blanking set-
tings: 0: Beam is interrupted; 
no blanking settings
1: Beam is interrupted; blank-
ing setting: beam = 0 (inter-
rupted)
2: Beam is interrupted; blank-
ing setting: beam = 1 (free 
light path)
3: Beam is interrupted; blank-
ing setting: suppressed beam 
= adjacent beam with smaller 
beam number
4: Beam is interrupted; blank-
ing setting: suppressed beam 
= adjacent beam with larger 
beam number
128: Free light path; no blank-
ing settings
129: Free light path; blanking 
setting: beam = 0 (inter-
rupted)
130: Free light path; blanking 
setting: beam = 1 (free light 
path)
131: Free light path; blanking 
setting: suppressed beam = 
adjacent beam with smaller 
beam number
132: Free light path; blanking 
setting: suppressed beam = 
adjacent beam with larger 
beam number

Notes:
This object cannot be used as 
TPDO mapping.
The data can be read for 64 
beams. The first beam of this 
block output is selected via 
the “index for block access for 
the extended beam data” 
(0x2912).

Index for block access
(for the extended beam data)

2912 t16U RW 1 1774 1 Defines the first logical beam 
for the evaluation of extended 
beam data.

Parameter Index
(hex.)

Sub-
index
(hex.)

Data 
type

Access Min. 
value

Max. value Default Explanation

Information on the status of the light curtain.
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Parameter Index
(hex.)

Sub-
index

Data 
type

Access Min. 
value

Max. value Default Explanation

Device status 2162 t16S RO 0: Normal function
1: Teach error
2: Internal temperature/volt-
age monitoring
3: Invalid configuration
4: Hardware error
5: 24 V voltage error (supply 
voltage UB)
6: Transmitter and receiver 
incompatible
7: No connection to transmit-
ter
8: Soiling
9: Teaching necessary
10: Measurement not active. 
The device

• reconfigures itself
• (re)starts
• waits for the first trigger 

pulse
• was manually stopped

11: Frequency of trigger sig-
nal too high

RX error field 2600 t16U RO For internal diagnosis only

KX error field 2601 t16U RO For internal diagnosis only
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11 Example configurations

11.1 Example configuration - Reading out 64 beams (beam-stream)
The beam-stream evaluation function is used, e.g., for evaluating the size and position of objects on a 
transport system.

11.1.1 Configuration of beam-stream process data via IO-Link interface
Map the beam states of the individual optical cascades in the CML 700i to the process data as follows.

11.1.2 Configuration of beam-stream process data via CANopen interface
Map the TPDO1 as follows.

These 32 bits are to be read as follows:

This means that 4 x 16 bit objects can be mapped per PDO → 64 beams.

11.2 Example configuration - Mapping of beams 1 … 32 to output pin 2

11.2.1 Configuration of area/output mapping (general)
The following table shows an example configuration for an area mapping to an output. In this example, 
beams 1 … 32 are to be applied to output pin 2 on interface X1.
Map beams 1 … 32 to area 01.

Evaluation function 01
(group 6)

Index 72, bit offset 120 = 1 The first optical cascade (beams 1 … 16) is transmitted in process data module 01

Evaluation function 02
(group 6)

Index 72, bit offset 112 = 2 The second optical cascade (beams 17 … 32) is transmitted in process data module 02

Evaluation function 03
(group 6)

Index 72, bit offset 104 = 3 The third optical cascade (beams 33 … 48) is transmitted in process data module 03

Evaluation function 04
(group 6)

Index 72, bit offset 96 = 4 The fourth optical cascade (beams 49 … 64) is transmitted in process data module 04

MAPPINGENTRY1 24120110 Index 0x2412 sub-index 01 is mapped, Length of the mapped object: 16 bit

MAPPINGENTRY2 24120210 Index 0x2412 sub-index 02 is mapped, Length of the mapped object: 16 bit

MAPPINGENTRY3 24120310 Index 0x2412 sub-index 03 is mapped, Length of the mapped object: 16 bit

MAPPINGENTRY4 24120410 Index 0x2412 sub-index 04 is mapped, Length of the mapped object: 16 bit

31 16 15 8 7 0

Index Sub-index Length

MSB LSB

Description / variables

Display detailed area configuration
Value: 0 = area 01

Configuration of area 01

Area
Value: 1 = active

Logical behavior of the area Value: 0
Normal - light switching 
(i.e., switching if beams are 
free)

Value: 1
Inverted - dark switching 
(i.e., switching if beams are 
interrupted)

Value: 0
Normal - light switching

Value: 1
Inverted - dark switching

Start beam of area
Value: 1 1 1 1

End beam of area
Value: 32 32 32 32
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 Configure pin 2 as area output.

Map pin 2 to configured area 1.

Possible additional area-to-pin configurations:
Map pin 2 to configured area 8.

Map the configured areas 1 and 8 (OR-linked) to the corresponding switching output.

11.2.2 Configuration of an area/output mapping via IO-Link interface
Map the beams to output pin 2 as follows.

Number of active beams for 
area ON
Value: 32 32 1 1

Number of active beams for 
area OFF
Value: 31 31 0 0

Switching behavior
Value: 0 = normal - light 
switching (i.e., switching if 
beams are free)

Output 1 if all beams are 
free.
Output 0 if a beam is inter-
rupted or if more than a 
beam are interrupted.

Output 0 if all beams are 
free or 1 … 31 beams are 
free.
Output 1 only if 32 beams 
are interrupted.

Output 1 if all beams are 
free or as long as 1 … 31 
beams are free.
Output 0 if 32 beams are 
interrupted.

Output 0 if all beams are 
free.
Output 1 as soon as a 
beam is interrupted.

Switching behavior
Value: 1 = inverted - dark 
switching (i.e., switching if 
beams are interrupted)

Output 0 if all beams are 
free.
Output 1 if one or more 
beams are interrupted.

OR function

Output 1 if all beams are 
free or 1 … 31 beams are 
free.
Output 0 only if 32 beams 
are interrupted.

AND function

Output 0 if all beams are 
free or as long as 1 … 31 
beams are free.
Output 1 if 32 beams are 
interrupted.

Output 1 if all beams are 
free.
Output 0 as soon as a 
beam is interrupted.

Description / variables

Configuration of digital inputs/outputs

Input/output selection Value: 0 = output Pin 2 functions as digital output

Function of the switching output Value: 1 = switching output (area 1 … 32) The switching output signals the logical states of beam 
areas 1 … 32

Digital Output 2 Settings

Area mapping 32 … 1 
(OR combination)

0b0000000000000000000000000000001 Every area is displayed as a bit.

Digital Output 2 Settings

Area mapping 32 … 1 
(OR combination)

0b0000000000000000000000010000000

Digital Output 2 Settings

Area mapping 32 … 1 
(OR combination)

0b0000000000000000000000010000001

Configuration of area 01
(group 14)

Index 100, bit offset 104: = 1 Area 01 active

Index 100, bit offset 96: = 0 Light switching

Index 100, bit offset 80: = 1 Start beam of area

Index 100, bit offset 64: = 32 End beam of area

Index 100, bit offset 48: = 32 Number of active beams for area ON

Index 100, bit offset 32: = 31 Number of active beams for area OFF
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11.2.3 Configuration of area/output mapping via CANopen interface
Map the beams to output pin 2 as follows.

11.3 Example configuration - Hole recognition
The following table shows an example configuration for hole recognition for web material with signaling of 
a hole at output pin 2. Example of detection beginning with a free beam with fixed/dynamic web position.
 First activate and configure a beam area (e.g., area 01).

Map the area to the corresponding switching output.

Digital IO Pin 2 Settings
(group 10)

Index 80, bit offset 24: = 0 Pin 2 as output

Index 80, bit offset 16: = 1 Switching behavior inverted

Index 80, bit offset 0: = 1 Switching output area 32 … 1

Index 84, bit offset 0: = 1 Bit mapping of area 01 to pin 2

Configuration of area 01
(module 8)

Index 0x2170 sub 01: = 1 Area 01 active

Index 0x2170 sub 02: = 0 Light switching

Index 0x2170 sub 03 = 1 Start beam of area

Index 0x2170 sub 04: = 32 End beam of area

Index 0x2170 sub 05: = 32 Number of active beams for area ON

Index 0x2170 sub 06: = 31 Number of active beams for area OFF

Switching level of inputs/out-
puts
(module 7)

Index 0x2151 sub 01: = 0 Pin 2 as output

Index 0x2151 sub 03: = 1 Switching behavior inverted

Index 0x2151 sub 04: = 1 Switching output area 32 … 1

Index 0x2155 sub 03: = 1 Bit mapping of area 01 to pin 2

Description / variables

Configuration of area 01

Area
Value: 1 = active

01 This area is active and is then mapped to output pin 2.

Logical behavior of the area
Value: 0 = normal - light switching

00 Switching in case of free beams.

Start beam of area
Value: FIB for dynamic web position or fixed position 
value, if specified

FIB If a hole is to be detected in a web with arbitrary position or width, the value 
FIB is to be set for the start beam.
With fixed position value, the start beam of the area is to be set.

End beam of area
Value: LIB for dynamic web position or fixed position 
value, if specified

LIB If a hole is to be detected in a web with arbitrary position or width, the value LIB 
is to be set for the end beam.
With fixed position value, the end beam of the area is to be set.

Number of active beams for area ON
Value: 1

1 With this setting, the area (output) switches as soon as one or more beams are 
not interrupted.

Number of active beams for area OFF
Value: 0

0

Description / variables

Configuration of pin 2

Input/output selection Value: 0 = output Pin 2 functions as digital output

Function of the switching output Value: 1 = switching output area 1 … 32 The switching output signals the logical states of beam 
areas 1 … 32

Switching behavior Switching behavior
Value: 0 = normal - light switching
Value: 1 = inverted - dark switching

Configuration according to the necessary switching 
behavior of the output
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Map configured area 1 to pin 2.

11.3.1 Configuration of hole recognition via IO-Link interface
 For hole recognition for web material map hole indication to output pin 2.

11.3.2 Configuration of hole recognition via CANopen interface
 For hole recognition for web material map hole indication to output pin 2.

11.4 Example configuration - Activating and deactivating blanking areas

11.4.1 Configuration of blanking areas (general)
 Perform the following settings to activate or deactivate blanking areas.
Example: automatic blanking of two areas during teaching

Example: Deactivation/resetting of auto blanking

Digital Output 2 Settings

Area mapping 32 … 1 
(OR combination)

0b 0000 0000 0000 0000 0000 0000 0000 0001

Configuration of area 01
(group 14)

Index 00, bit offset 104: = 1 Area 01 active

Index 100, bit offset 96: = 0 Light switching

Index 100, bit offset 80: = 65534 Start beam of the area dynamic: on 65534 (start beam = FIB)

Index 100, bit offset 64: = 65532 End beam of the area dynamic: on 65532 (start beam = LIB)

Index 100, bit offset 48: = 1 Number of active beams for area ON

Index 100, bit offset 32: = 0 Number of active beams for area OFF

Digital IO Pin 2 Settings
(group 10)

Index 80, bit offset 24: = 0 Pin 2 as output

Index 80, bit offset 16: = 1 Switching behavior inverted

Index 80, bit offset 0: = 1 Switching output area 32 … 1

Index 84, bit offset 0: = 1 Bit mapping of area 01 to pin 2

Configuration of area 01
(module 8)

Index 0x2170 sub 01: = 1 Area 01 active)

Index 0x2170 sub 02: = 0 (Light switching

Index 0x2170 sub 03: = 65534 Start beam of the area dynamic: on 65534 (start beam = FIB)

Index 0x2170 sub 04: = 65532 End beam of the area dynamic: on 65532 (start beam = LIB)

Index 0x2170 sub 05: = 1 Number of active beams for area ON

Index 0x2170 sub 06: = 0 Number of active beams for area OFF

Switching level of inputs/outputs
(module 7)

Index 0x2151 sub 01: = 0 Pin 2 as output

Index 0x2151 sub 03: = 1 Switching behavior inverted

Index 0x2151 sub 04: = 1 Switching output area 32 … 1

Index 0x2155 sub 03: = 1 Bit mapping of area 01 to pin 2

Blanking settings Parameter Number of auto blanking areas: = 2 Two blanking areas permitted

Parameter Auto blanking (during teaching): = 1 Automatic blanking-area configuration active

System commands Parameter Teach command: = 1 Execute teach command

Blanking settings Parameter Number of auto blanking areas: = 0 No blanking areas permitted

Parameter Auto blanking (during teaching): = 0 Automatic blanking area configuration not active
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11.4.2 Configuration of blanking areas via IO-Link interface
 Perform blanking area activation and deactivation.

Example: automatic blanking of two areas during teaching

In the background, the values of objects INDEX 76 sub-index 3 et seq. are calculated and stored in non-
volatile memory. Upon successful teach completion, all other objects of index 76 are stored in non-volatile 
memory if index 79, sub-index 2 is set to value 0 = non-volatile storage of teach values.

Example: Deactivation/resetting of auto blanking

11.4.3 Configuration of blanking areas via CANopen interface
 Perform blanking area activation and deactivation.
Example: automatic blanking of two areas during teaching

In the background, the values of objects 0x2104 sub 04 and 0x2104 sub 05 as well as 0x2104 sub 07 and 
0x2104 sub 08 are calculated and stored in non-volatile memory. Following a successful teach, all other 
0x2104 objects are stored in non-volatile memory if 0x2103 sub 02 is set to value 0 = non-volatile storage 
of teach values.
Example: Deactivation/resetting of auto blanking

Blanking settings Parameter Function for blanking area/logical value 
for blanking area 1:

= 0 No beams blanked

Parameter Function for blanking area/logical value 
for blanking area 2:

= 0 No beams blanked

System commands Parameter Teach command: = 1 Execute teach command

Blanking settings
(group 8)

Index 76, bit offset 200: = 2 Two blanking areas permitted

Index 76, bit offset 192: = 1 Automatic blanking-area configuration active

System commands
(group 1)

Index 2 = 162 Execute teach

Blanking settings
(group 8)

Index 76, bit offset 200: = 0 No blanking areas permitted

Index 76, bit offset 192: = 0 Automatic blanking area configuration not active

Blanking settings
(group 8)

Index 76, bit offset 176: = 0 No beams blanked

Index 76, bit offset 176: = 0 No beams blanked

System commands
(group 1)

Index 2: = 162 Execute teach

Blanking settings
(module 6)

Index 0x2104 sub 01: = 2 Two blanking areas permitted

Index 0x2104 sub 02: = 1 Automatic blanking-area configuration active

Commands
(module 9)

Index 0x2200 sub 01: = 3 Execute teach

Blanking settings
(module 6)

Index 0x2104 sub 01: = 0 No blanking areas permitted

Index 0x2104 sub 02: = 0 Automatic blanking area configuration not active

Blanking settings
(module 6)

Index 0x2104 sub 03: = 0 No beams blanked

Index 0x2104 sub 03: = 0 No beams blanked

Commands
(module 9)

Index 0x2200 sub 01: =  3 Execute teach
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11.5 Example configuration – smoothing

11.5.1 Smoothing configuration (general)
Make the following settings for smoothing.
Example: Smoothing of four interrupted beams

Example: Inverted smoothing of four interrupted beams

11.5.2 Configuration of smoothing via IO-Link interface
 Assign the desired value for smoothing.
Example: Smoothing of four interrupted beams

Example: Inverted smoothing of four interrupted beams

11.5.3 Configuration of smoothing via CANopen interface
 Assign the desired value for smoothing.
Example: Smoothing of four interrupted beams

Example: Inverted smoothing of four interrupted beams

11.6 Example configuration - Cascading

11.6.1 Configuration of a cascading arrangement (general)
The following figure shows an example for a timing sequence of a cascading arrangement with three light 
curtains.

Smoothing settings Parameter Smoothing -– less than i interrupted 
beams are ignored:

= 4 Beams are taken into account in the evaluation once 
there are four or more interrupted beams

Smoothing settings Parameter Inverted smoothing - less than i free 
beams are ignored:

= 4 Beams are taken into account in the evaluation once 
there are four or more free beams

If the set configuration of the light curtain is running stably in your application and the measure-                
ment field resolution can be reduced, e.g. in the case of objects to be detected which are consi-                 
derably larger than 10 mm, it is recommended to set Smoothing and Inverted smoothing to a               
value > 1.

General configuration 
(group 4)

Index 71, bit offset 8: = 4 Beams are taken into account in the evaluation once there are four or more 
interrupted beams

General configuration
(group 4)

Index 71, bit offset 0: = 4 Beams are taken into account in the evaluation once there are four or more 
free beams

General configuration
(module 3)

Index 2100 sub 03: =  4 Beams are taken into account in the evaluation once there are four or more 
interrupted beams

General configuration
(module 3)

Index 2100 sub 4: = 4 Beams are taken into account in the evaluation once there are four or more 
free beams
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1 Master light curtain LC1
2 Slave light curtain LC2
3 Slave light curtain LC3
4 Total cycle time

Figure 11.1: Example: cascading with three light curtains

Configuring light curtain 1:
 Configure the trigger settings (triggered, master, total cycle time).

 Configure the digital IOs (pin 5) settings.

Configuring light curtain 2:
 Configure the trigger settings (triggered, slave, delay time).

 Configure the digital IOs (pin 5) settings.

LV2

LV1

t [µs]

LV3

LV1-OUT

1

2

3

4

tLV2 tLV3tLV1

Cascading configuration

Cascading 1: Active
Note: With cascading operation, the master must also be set to 1 (active)!

Function type 1: Master (sends trigger signal)

Master cycle time Total cycle time (= sum of cycle times of the light curtains LC1+LC2+LC3)
Duration of a TRIGGER cycle in ms

Digital IO1 (pin 5) settings

 Pin 5 - Input/output selection 1: Output

 Pin 5 - Switching behavior 0: Light switching

 Pin 5 - Output function 3: Trigger output

Cascading configuration

Cascading 1: Active
Note: With cascading operation, the master must also be set to 1 (active)!

Function type 0: Slave (expects trigger signal)

Trigger delay time →  Scan [us] Enter cycle time of light curtain 1 (LC1)

Digital IO1 (pin 5) settings
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Configuring light curtain 3:
 Configure the trigger settings (triggered, slave, delay time).

 Configure the digital IOs (pin 5) settings.

11.6.2 Configuration of a cascading arrangement via IO-Link interface

CML700i frame arrangement for cascading with IO-Link interface wiring

1 Receiver
2 Transmitter
3 Interconnection cable 5 m (see table 17.3)
4 Connection cable 5 m (see table 17.4)
5 Interconnection cable 2 m (see table 17.3)

 Pin 5 - Input/output selection 1: Input

 Pin 5 - Switching behavior 0: Light switching

 Pin 5 - Output function 1: Trigger input

Cascading configuration

Cascading 1: Active
Note: With cascading operation, the master must also be set to 1 (active)!

Function type 0: Slave (expects trigger signal)

Trigger delay time →  Scan [us] Enter cycle time of light curtain 1 and light curtain 2 (= sum of cycle times of light curtains LC1+LC2)

Digital IO1 (pin 5) settings

 Pin 5 - Input/output selection 1: Input

 Pin 5 - Switching behavior 0: Light switching

 Pin 5 - Output function 1: Trigger input

2 2

1

5

1

2 3

4

13

4 4
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Configuring light curtain 1:
 Configure the trigger settings (triggered, master, total cycle time).

 Configure the digital IOs (pin 5) settings.

Configuring light curtain 2:
 Configure the trigger settings (triggered, slave, delay time).

 Configure the digital IOs (pin 5) settings.

Configuring light curtain 3:
 Configure the trigger settings (triggered, slave, delay time).

 Configure the digital IOs (pin 5) settings.

Cascading configuration
(group 7)

Index 73, bit offset 56 = 1 Cascading: active
Note: With cascading operation, the master must also be set to 1 (active)!

Index 73, bit offset 48 = 1 Function type: master - sends trigger signal

Index 73, bit offset 32 Master cycle time: total cycle time of all light curtains (LC1+LC2+LC3)
Duration of a TRIGGER cycle in ms

Digital IO1 (pin 5) settings
(group 10)

Index 81, bit offset 24 = 0 Pin 5 - input/output selection: output

Index 81, bit offset 16 = 0 Pin 5 - switching behavior: light switching

Index 81, bit offset 00 = 3 Pin 5 - output function: trigger output

Cascading configuration
(group 7)

Index 73, bit offset 56 = 1 Cascading: active
Note: With cascading operation, the master must also be set to 1 (active)!

Index 73, bit offset 48 = 0 Function type: slave - expects trigger signal

Index 73, bit offset 00 Delay time Trigger →  Scan [µs]: enter cycle time of light curtain 1 (LC1)

Digital IO1 (pin 5) settings
(group 10)

Index 81, bit offset 24 = 1 Pin 5 - input/output selection: input

Index 81, bit offset 16 = 0 Pin 5 - switching behavior: light switching

Index 81, bit offset 08 = 1 Pin 5 - output function: trigger input

Cascading configuration
(group 7)

Index 73, bit offset 56 = 1 Cascading: active
Note: With cascading operation, the master must also be set to 1 (active)!

Index 73, bit offset 48 = 0 Function type: slave - expects trigger signal

Index 73, bit offset 32 Delay time Trigger →  Scan [µs]: enter cycle time of light curtain 1 and light 
curtain 2 (= sum of the cycle times of light curtains LC1+LC2)

Digital IO1 (pin 5) settings
(group 10)

Index 81, bit offset 24 = 1 Pin 5 - input/output selection: input

Index 81, bit offset 16 = 0 Pin 5 - switching behavior: light switching

Index 81, bit offset 08 = 1 Pin 5 - output function: trigger input



Example configurations

Leuze electronic GmbH + Co. KG CML 720i Ex 108

11.6.3 Configuration of a cascading arrangement via CANopen interface

CML700i frame arrangement for cascading with CANopen interface wiring

1 Receiver
2 Transmitter
3 Y-connection and interconnection cable, 0.15 m/5 m (see table 17.3)
4 Y-CAN fieldbus interconnection cable, 0.25 m/0.35 m (see table 17.5)
5 Y-CAN fieldbus interconnection cable, 0.25 m/5 m (see table 17.5)
6 Y-connection and interconnection cable, 0.15 m/2 m (see table 17.3)

Configuring light curtain 1:
 Configure the trigger settings (triggered, master, total cycle time).

 Configure the digital IOs (pin 5) settings.

Configuring light curtain 2:
 Configure the trigger settings (triggered, slave, delay time).

 Configure the digital IOs (pin 5) settings.

2 2

1

6

1

2 3

5

5

13

4

Cascading configuration
(module 12)

Index 0x2102 sub 01 = 1 Cascading: active
Note: With cascading operation, the master must also be set to 1 (active)!

Index 0x2102 sub 02 = 1 Function type: master - sends trigger signal

Index 0x2102 sub 05 Master cycle time: total cycle time of all light curtains (LC1+LC2+LC3)
Duration of a trigger cycle in ms

Switching level of the 
inputs/outputs
(module 10)

Index 0x2152 sub 04 = 1 Pin 5 - input/output selection: output

Index 0x2152 sub 03 = 0 Pin 5 - switching behavior: light switching

Index 0x2152 sub 01 = 3 Pin 5 - output function: trigger output

Cascading configuration
(module 12)

Index 0x2102 sub 01 = 1 Cascading: active
Note: With cascading operation, the master must also be set to 1 (active)!

Index 0x2102 sub 02 = 0 Function type: slave - expects trigger signal

Index 0x2102 sub 03 Delay time Trigger →  Scan [µs]: enter cycle time of light curtain 1 (LC1)
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Configuring light curtain 3:
 Configure the trigger settings (triggered, slave, delay time).

 Configure the digital IOs (pin 5) settings.

Switching level of the 
inputs/outputs
(module 10)

Index 0x2152 sub 04 = 1 Pin 5 - input/output selection: input

Index 0x2152 sub 03 = 0 Pin 5 - switching behavior: light switching

Index 0x2152 sub 02 = 1 Pin 5 - input function: trigger input

Cascading configuration
(module 12)

Index 0x2102 sub 01 = 1 Cascading: active
Note: With cascading operation, the master must also be set to 1 (active)!

Index 0x2102 sub 02 = 0 Function type: slave - expects trigger signal

Index 0x2102 sub 03 Delay time Trigger →  Scan [µs]: enter cycle time of light curtain 1 and light 
curtain 2 (= sum of the cycle times of light curtains LC1+LC2)

Switching level of the 
Inputs/outputs
(module 10)

Index 0x2152 sub 04 = 1 Pin 5 - input/output selection = input

Index 0x2152 sub 03 = 0 Pin 5 - switching behavior = light switching

Index 0x2152 sub 02 = 1 Pin 5 - input function = trigger input

NOTICE
Halation effects can influence the measurement!


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12 Connecting to a PC – Sensor Studio
The Sensor Studio configuration software – in combination with an IO-Link USB master – provides a 
graphical user interface for the operation, configuration and diagnosis of sensors with IO-Link configuration 
interface (IO-Link devices), independent of the selected process interface.
Each IO-Link device is described by a corresponding IO Device Description (IODD file). After importing the 
IODD file into the configuration software, the IO-Link device connected to the IO-Link USB master can be 
operated, configured and checked – conveniently and in multiple languages. An IO-Link device that is not 
connected to the PC can be configured offline.
Configurations can be saved and reopened as projects for transferring back to the IO-Link device at a later 
time.

The Sensor Studio configuration software is designed according to the FDT/DTM concept:

• Make individual configuration settings for the light curtain in the Device Type Manager (DTM).
• The individual DTM configurations of a project can be called up via the frame application of the Field 

Device Tool (FDT).
• Communication DTM: IO-Link USB master
• Device DTM: IO-Link device/IODD for CML 700i

Procedure for the installation of the software and hardware:
 Install the Sensor Studio configuration software on the PC.
 Install the driver for the IO-Link USB master on the PC.
 Connect the IO-Link USB master to the PC.
 Connect the CML 700i (IO-Link device) to the IO-Link USB master.
 Install IO-Link device DTM with IODD file for CML 700i in the Sensor Studio FDT frame.

12.1 System requirements
To use the Sensor Studio configuration software, you need a PC or laptop with the following specifications:

Only use the Sensor Studio configuration software for products manufactured by Leuze.

The Sensor Studio configuration software is offered in the following languages: German, Eng-            
lish, French, Italian and Spanish.

The FDT frame application of the Sensor Studio supports all languages; all languages may not              
be supported in the IO-Link device DTM (Device Type Manager).

NOTICE
Configuration changes only via the control and the fieldbus interface!
 Always perform the configuration for process mode via the control and, if applicable, the fieldbus inter-

face.
In process mode, only the configuration conveyed via the control is active. The configuration changes 
made via Sensor Studio are only active in process mode if they were previously transmitted 1:1 to the 
control.
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Table 12.1: System requirements for Sensor Studio installation

12.2 Installing Sensor Studio configuration software and IO-Link USB master

12.2.1 Installing the Sensor Studio FDT frame

 Start the PC and insert the Sensor Studio & IO-Link USB Master data carrier. 
The language selection menu starts automatically. 
If the language selection menu does not start automatically, double-click the start.exe file.
 Select a language for the interface text in the Installation Wizard and software.
The installation options are displayed.
 Select Leuze electronic Sensor Studio and follow the instructions on the screen. 
The Installation Wizard installs the software and places a shortcut on the desktop (  ).

12.2.2 Installing drivers for IO-Link USB master
 Select the IO-Link USB Master installation option and follow the instruction on the screen. 

Operating system Windows 7
Windows 8

Computer • Processor type: 1 GHz or higher
• USB interface
• CD-ROM drive
• Main memory 

• 1 GB RAM (32-bit operating system)
• 2 GB RAM (64-bit operating system)

• Keyboard and mouse or touchpad

Graphics card DirectX 9 graphic device with WDDM 1.0 or higher driver 

Additionally required 
capacity for Sensor 
Studio and IO-Link 
device DTM

350 MB hard drive memory
64 MB main memory

Administrator privileges on the PC are necessary for installing Sensor Studio. 

The installation of the Sensor Studio configuration software is done via supplied data carrier             
Sensor Studio & IO-Link USB master.

For subsequent updates, you can find the most recent version of the Sensor Studio configuration              
software on the Internet at www.leuze.com 

NOTICE
First install the software!
 Do not yet connect the IO-Link USB master to the PC.

First install the software.

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-                 
lation. 

You can install the communication DTM (IO-Link USB master) and the device DTM (IO-Link             
device CML 700i) in the existing FDT frame.



Connecting to a PC – Sensor Studio

Leuze electronic GmbH + Co. KG CML 720i Ex 112

The Installation Wizard installs the software and places a shortcut on the desktop (  ).

12.2.3 Connecting IO-Link USB master to the PC
The light curtain is connected to the PC via the IO-Link USB master (see table 17.10).
 Connect the IO-Link USB master to the plug-in power supply unit or the mains supply.

 Connect the PC to the IO-Link USB master.

1 IO-Link USB master
2 Plug-in power supply unit
3 PC

Figure 12.1: PC connection via the IO-Link USB master

 The wizard for searching for new hardware starts and installs the driver for the IO-Link USB master on 
the PC.

12.2.4 Connect the IO-Link USB master to the light curtain

Prerequisites:
• IO-Link USB master and PC are connected via the USB interconnection cable.
• IO-Link USB master is connected to the mains supply with the plug-in power supply unit.

Included in the delivery contents of the IO-Link USB master is a USB interconnection cable for               
connecting the PC to the IO-Link USB master as well as a plug-in power supply unit and a short                  
description. 

The mains supply of the IO-Link USB master via the plug-in power supply unit is only activated                
if IO-Link USB master and PC are connected via the USB interconnection cable.

1

2

3

NOTICE
Connect the plug-in power supply unit for IO-Link USB master!
 To connect a light curtain, the plug-in power supply unit must be connected to the IO-Link USB master 

and the mains supply.
The voltage supply via the USB interface of the PC is permissible only for IO-devices with a current 
consumption of up to 40 mA at 24 V.

Included in the delivery contents of the IO-Link USB master is a USB interconnection cable for               
connecting the PC to the IO-Link USB master as well as a plug-in power supply unit and a short                  
description. 

The voltage supply of the IO-Link USB master and the light curtain via the plug-in power supply                
unit is only activated if IO-Link USB master and PC are connected via the USB interconnection               
cable.
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 Connect the IO-Link USB master to the receiver.

 CML 700i with CANopen or IO-Link interface:
Connect the IO-Link USB master to the short end of the Y-connection cable (see figure 12.2).
If the Y-connection cable is too short to connect the IO-Link USB master, use a interconnection/syn-
chronization cable to extend the cable (to be ordered separately, see table 17.7).

1 CML 700i receiver
2 IO-Link USB master
3 Plug-in power supply unit
4 PC

Figure 12.2: CML 700i (fieldbus) connection to the IO-Link USB master

12.2.5 Installing the DTM and IODD

Prerequisites:
• The light curtain is connected to the PC via the IO-Link USB master.
• FDT frame and driver for IO-Link USB master are installed on the PC.

 Select the IO-Link device DTM (User Interface) installation option and follow the instructions on the 
screen. 

The Installation Wizard installs the DTM and the IO Device Description (IODD) for the light curtain.

12.3 Starting the Sensor Studio configuration software

Prerequisites: 
• The light curtain has been mounted (see chapter 6) and connected (see chapter 7) correctly.
• The Sensor Studio configuration software is installed on the PC (see chapter 12.2 "Installing 

Sensor Studio configuration software and IO-Link USB master").
• The light curtain is connected to the PC via the IO-Link USB master (see chapter 12.2 "Installing 

Sensor Studio configuration software and IO-Link USB master").

2

31

4

DTM and IODD for all IO-Link devices currently available from Leuze are installed.

NOTICE
IO Device Description (IODD) not up-to-date!
The values in the IODD file supplied with the device may no longer be up-to-date.
 Download the up-to-date IODD file from the Internet at www.leuze.com.
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 Start the Sensor Studio configuration software by double-clicking the Sensor Studio icon (  ).
The Mode selection of the Project Wizard is displayed automatically or under the File menu item.
 Select the Device selection without communication connection (offline) configuration mode and click on 

[Next].
The Project Wizard displays the device selection list of the configurable devices.

Figure 12.3: Device selection for CML 700i measuring light curtain

 Select the connected light curtain according to the configuration in the Device Selection and click on 
[Next].
In the devicedescription in the device selection list, the values for the bit rate and PD length configura-
tion parameters for the respective light curtain are listed. Factory settings on delivery: 
Bit rate: COM2
PD length: 2 bytes

The device manager (DTM) of the connected light curtain starts with the offline view for the Sensor Studio 
configuration project. 
 Establish the online connection to the connected light curtain.

In the Sensor Studio FDT frame, click on the [Establish connection with device] button (  ).
In the Sensor Studio FDT frame, click on the [Online parameters] button (  ).

The IO-Link USB master synchronizes with the connected light curtain and the current configuration data 
and process data are displayed in the device manager (DTM). 
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Figure 12.4: Configuration project: Sensor Studio device manager (DTM) for CML 700i

 The menus of the Sensor Studio device manager (DTM) can be used to change the configuration of the 
connected light curtain or read out process data.
The user interface of the Sensor Studio device manager (DTM) is largely self-explanatory.
The online help system provides information on the menu items and adjustment parameters. Select the 
Help menu item in the menu [?].

Error message when [establishing connection with the device]
If the device selected in the Device selection list of the Sensor Studio Project Wizard does not match the 
configuration (bit rate and PD length) of the connected light curtain, an error message is displayed. 
Under IDENTIFICATION > CxL-7XX Device IDs, you will find a list with the assignment of the device IDs 
displayed in the error message to the device description in the device selection list.
 Change the device selection in the device selection list according to the configuration (bit rate and  

PD length) of the connected light curtain. 
Alternatively, you can set the configuration (bit rate and PD length) of the light curtain in the receiver 
control panel corresponding to the device selection in the Device selection list.

 In the Sensor Studio FDT frame, click on the [Establish connection with device] button (  ).

12.4 Short description of the Sensor Studio configuration software
This chapter contains information and explanations on the individual menu items and adjustment param-
eters of the Sensor Studio configuration software and the device manager (DTM) for CML 700i measuring 
light curtains. 
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The device managers (DTM) for light curtains of the Sensor Studio configuration software have the 
following main menus and functions:

• IDENTIFICATION (see chapter 12.4.2)
• CONFIGURATION (see chapter 12.4.3)
• PROCESS (see chapter 12.4.4)
• DIAGNOSIS (see chapter 12.4.5)

12.4.1 FDT frame menu

12.4.2 IDENTIFICATION function

• Operating information: Information on operating the device manager (DTM)
• Technical description: The available original operating instructions of the device in pdf format
• CML-7XX: Table with the assignment of device IDs to the devicedescription in the device selection 

list in the Sensor Studio Project Wizard. 
The information is needed if an error message is displayed when connecting with the device.

12.4.3 CONFIGURATION function

• Save permanently: Configuration changes via Sensor Studio are effective immediately but are lost if 
the device is de-energized. 
With Save permanently, the configuration set via Sensor Studio is stored in non-volatile memory in 
the device.

• Teach: The sensitivity of the teach event (see chapter 8.2 "Teaching the environmental conditions") 
can only be set via the Sensor Studio configuration software.

• Upload device data set from device (  ): The configuration is uploaded from the device to the 
device manager (DTM), e.g., to update the online view in Sensor Studio after the configuration was 
changed via the receiver control panel.

• Upload device data set from device (  ) / Synchronize with device (  ): 

• If the [Upload device data set from device] button (  ) is displayed in the device manager 
(DTM), the Sensor Studio display shows the current configuration of the light curtain.

• If the [Synchronize with device] button (  ) is displayed in the device manager (DTM), the Sen-
sor Studio display is not consistent with the current configuration of the light curtain.

This chapter does not include a complete description of the Sensor Studio configuration soft-             
ware.

Complete information on the FDT frame menu and on the functions in the device manager (DTM)               
can be found in the online help system.

The online help system displays information on the menu items and adjustment parameters for             
each function. Select the Help menu item in the menu [?]

You can find complete information on the FDT frame menu in the online help system. Select the                
Help menu item in the menu [?].

NOTICE
Configuration for process mode only via the control!
 Always configure process mode via the control and, if applicable, the fieldbus interface.

In process mode, only the configuration conveyed via the control is active. The configuration changes 
made via Sensor Studio are only active in process mode if they were previously transmitted 1:1 to the 
control.
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If parameters are changed in the device manager (DTM) that affect other parameters (e.g., if              
changing the beam mode causes the configured logical beams to change), the changes to these              
parameters are configured in the device – but are not yet displayed in the Sensor Studio display. 
Click on the [Synchronize with device] button (  ) to synchronize the Sensor Studio display with                
the current configuration of the light curtain. Following successful synchronization, the [Upload           
device data set from device] button (  ) is displayed in the device manager (DTM).

12.4.4 PROCESS function

• The Process function offers graphical visualizations of the process data of the connected light cur-
tain.

Figure 12.5: Graphical visualization: object position

• [Cyclical refresh] button (  ): Starts the cyclical acquisition of the process data, which are graphi-
cally depicted under Numerical display, Beam-stream display and Areas and outputs. Each graphical 
display covers up to 300 seconds.

• Beam-stream display: Using the [Show or hide the graphical cursor] button (  ), you can move the 
graphical cursor in the visualization, e.g., to evaluate the time difference between two events. 
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Figure 12.6: Graphical visualization: Beam-stream display

12.4.5 DIAGNOSIS function
The DIAGNOSIS function offers the following commands.

• Reset device, i.e., restart the connected light curtain
• Store configuration in non-volatile memory (see chapter 12.4.3)

12.4.6 Exiting Sensor Studio 
After completing the configuration settings, close the Sensor Studio configuration software
 Exit the program via File > Exit.
 Save the configuration settings as a configuration project on the PC.
You can open the configuration project again at later time via File > Open or via the Sensor Studio Project 
Wizard (  ).
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13 Troubleshooting

13.1 What to do in case of failure?
After switching on the light curtain, display elements (see chapter 3.4) assist in checking the proper func-
tion and troubleshooting.
In case of error, you can determine the error from the LED displays. With the error message you can deter-
mine the cause of the error and initiate measures to rectify it.

13.2 Operating indicators of the LEDs

Table 13.1: Receiver LED displays - state and causes

NOTICE
If the light curtain responds with an error display, you will often be able to eliminate the cause yourself!
 Switch off the system and leave it switched off.
 Analyze and eliminate the cause of the fault using the following table.
 If you are unable to rectify the error, contact the Leuze branch responsible for you or call the Leuze 

customer service (see chapter 15 "Service and support").

LED green LED yellow State Possible cause

ON
(continuous 
light)

- Sensor ready

OFF OFF Sensor not ready Interruption of the operating voltage;
Light curtain in start-up phase

OFF Flashing
(15 Hz)

Missing function reserve Soiling of the lens covers
Misalignment of transmitter or 
receiver
Operating range exceeded

Flashing synchronously 
(3 Hz)

Teach running

Flashing synchronously 
(9 Hz)

Teach error Soiling of the lens covers
Operating range exceeded

Flashing alternately (9 Hz) System error No connection between transmitter 
and receiver
Operating voltage too low
Receiver is not compatible with the 
transmitter
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Table 13.2: LED displays - causes and measures

13.3 Error codes in the display
The following error messages can be output in the form of status codes in the device display.

Table 13.3: Normal operation

Error Possible cause Measure

Teach error Soiling of the lens covers
Poor alignment of transmitter and 
receiver

Clean the lens cover on the receiver 
and on the transmitter.
Check alignment.

Function reserve too low Poor alignment of transmitter and 
receiver
Soiling of the lens covers

Adjust alignment.
Test with shorter distance between 
transmitter and receiver.
Clean the lens cover on the receiver 
and on the transmitter.

Alignment signal too low Poor alignment of transmitter and 
receiver
Soiling of the lens covers

Adjust alignment.
Test with shorter distance between 
transmitter and receiver.
Clean the lens cover on the receiver 
and on the transmitter.

Outputs are not active or 
change their state without a 
contour change in the mea-
surement field

Configuration data is read or writ-
ten

End configuration communication.

During teaching, the system checks whether the signals of all beams are within a certain corridor.               
If there are considerable deviations in the signal strength, this results in a teaching error and is                
indicated on the LEDs. The cause may be partial soiling of the lens cover.

Measure: clean the lens covers on the transmitter and receiver!

Soiling of the lens cover is indicated by the LEDs if the function reserve mode High, Medium or                 
Low is set (see chapter 8.4 "Setting the function reserve"). 

Status code Description

RxS 0x0100 CxL in normal mode, start-up phase still running

RxS 0x0180 CxL reconfigures itself after a configuration. Process data are invalid.

RxS 0x0190 The measurement system is not active (after a stop command or if the first trigger pulse 
is missing).

RxS 0x0200 The “Leuze AutoControl ACON function” has detected soiling.

RxS 0x0300 Teach parameters have been changed (teaching must be done) or default values are 
active.

RxS 0x0FFF CxL shuts down. Process data are invalid.
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Table 13.4: Warnings

Table 13.5: Errors (can be corrected)

Error code Description Possible cause (s)

RxS 0x1000 Device in teach mode, no new 
process data available

• Distance between transmitter and receiver too large 
or too small

• Poor alignment
• Soiling
• Extraneous light, especially mutual interference
• Beams are interrupted, but blanking is deactivated
• The maximum number of blanking areas is not suffi-

cient
• The number of beams to be blanked is greater than 

or equal to the number of all logical beams

RxS 0x1100
RxS 0x1001
RxS 0x11xy

Teaching error
Trigger frequency too high
The device could not end 
teach, no new process data 
available

RxS 0x111x Blanking error

RxS 0x112x Error due to weak signal
Individual beams do not reach 
the minimum reception level

RxS 0x113x Internal error
Device has reached the 
power limit

Error code Description Measures

RxS 0x2000 No communication possible between transmitter and 
receiver.

Check cable.

RxS 0x2001 Receiver/transmitter inconsistency.
The receiver is not compatible with the transmitter.

Replace transmitter. 

RxS 0x2100 The supply voltage is not sufficient. Check voltage supply.

RxS 0x2101 Tx: Supply voltage in transmitter insufficient. Check voltage supply.
If the voltage supply is OK, 
transmitter is defective.

RxS 0x2200 EEPROM data corrupt. Reset device to factory set-
tings.

RxS 0x23xy Configuration error.
xy gives information on the type of configuration error.

Contact service (see 
chapter 15).
Reset device to factory set-
tings.
Check parameters and 
parameter relation.

RxS 0x23F3 Configuration error – beam evaluation areas.
The switch-on and switch-off conditions must differ if they 
are unequal to zero and the area is active. 

Check the configuration of 
the beam evaluation areas. 
Reset device to factory set-
tings.

RxS 0x23F4 Configuration error – blanking.
Upper neighbor beam for beam “i” selected and lower 
neighbor beam for beam “i+1”.

Check the configuration of 
the blanking parameters 
(see chapter 9.3). 
Reset device to factory set-
tings.
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Table 13.6: Serious errors (cannot be corrected)

RxS 0x23F5 Configuration error – blanking.
Upper neighbor beam for beam “i” selected and no neigh-
bor beam exists.

Check the configuration of 
the blanking parameters 
(see chapter 9.3). 
Reset device to factory set-
tings.

RxS 0x23F6 Configuration error – blanking.
Lower neighbor beam for beam “i” selected and no neigh-
bor beam exists.

Check the configuration of 
the blanking parameters 
(see chapter 9.3). 
Reset device to factory set-
tings.

RxS 0x23F7 Configuration error – blanking.
Overlapping of the blanking areas.

Check the configuration of 
the blanking parameters 
(see chapter 9.3). 
Reset device to factory set-
tings.

RxS 0x23F8 Configuration error – blanking.
Start beam > end beam.

Check the configuration of 
the blanking parameters 
(see chapter 9.3). 
Reset device to factory set-
tings.

RxS 0x23FA Configuration error – time behavior.
The delay time is greater than the trigger cycle time/mea-
surement cycle time. 

Check the time behavior 
setting (see chapter 16.2). 
Reset device to factory set-
tings.

RxS 0x23FB Configuration error – time behavior.
The pulse width is greater than the trigger cycle time. 

Check the time behavior 
setting (see chapter 16.2). 
Reset device to factory set-
tings.

RxS 0x23FC Configuration error – time behavior.
The measurement cycle time is greater than the trigger 
cycle time. 

Check the time behavior 
setting (see chapter 16.2). 
Reset device to factory set-
tings.

Error code Description Measures

Error Description Measures

RxS 0x3003 Hardware error, receiver 5V supply

Return device following 
consultation with Service 
department (see 
chapter 15).

RxS 0x3005 Hardware error, receiver cascade
No receiver cascade or different LED number of transmitter 
and receiver

RxS 0x3007 Hardware error, inter-controller communication interrupted 

RxS 0x3008 Hardware error, different number of diodes at transmitter 
and receiver 

RxS 0x3009
RxS 0x300A

Hardware error, no Rx cascades
Hardware error, no Tx cascades

RxS 0x3100
RxS 0x3101

Error in the factory settings. Can only be rectified by repro-
gramming the device firmware.
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14 Care, maintenance and disposal

14.1 Cleaning
In the event of dust build-up on the sensor:
 Clean the sensor with a soft cloth; use a cleaning agent (commercially available glass cleaner) if nec-

essary.

14.2 Protective film
A protective film is available for the light curtains that protects the lens cover against dusts and liquids. 

• The receiver of the light curtain signals soiling of the lens cover via the LED indicator (see 
chapter 13.2).

• Soiled protective films can be quickly and gently removed and replaced.
• The protective film is 20 mm wide and available as a 350 m roll.

• Part designation: PT 20-CL3500
• Part no: 50143913

14.3 Servicing
Usually, the light curtain does not require any maintenance by the operator.
Repairs to the device must only be carried out by the manufacturer.
 For repairs, contact your responsible Leuze subsidiary or Leuze customer service (see chapter 15).

14.3.1 Firmware update
A firmware update can only be performed by Leuze customer service on-site or at the company headquar-
ters.
 For firmware updates, contact your responsible Leuze subsidiary or Leuze customer service (see 

chapter 15).

14.4 Disposing
For disposal observe the applicable national regulations regarding electronic components.

WARNING
Safe use of the sensor in potentially explosive areas!
 Observe the information on the safe use of sensors in potentially explosive areas; see chapter 2.5.

NOTICE
Do not use aggressive cleaning agents!
 Do not use aggressive cleaning agents such as thinner or acetone for cleaning the light curtains.

Use of improper cleaning agents can damage the lens cover.

NOTICE
 The lens cover of the light curtain must be dry and free of dust and grease.
 The protective film must be affixed on the lens cover free of air bubbles.
 Soiled protective film can be pulled off by hand and replaced.
 Brand new protective film slightly reduces the operating range limit of the light curtain.

Because the operating range limit of the light curtain significantly exceeds the operating range, the pro-
tective film does not typically reduce the operating range.
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15 Service and support
Defective devices are repaired in our service center competently and quickly. Leuze offers you an exten-
sive service packet to keep any necessary system downtimes to a minimum. 

Our service center requires the following information:
• Customer number
• Part designation or part number
• Serial number or batch number
• Reason for return with description

 
24-hour on-call service at:
+49 7021 573-0
 
Service hotline: 
+49 7021 573-123
Monday to Friday 8.00 a.m. to 5.00 p.m. (UTC+1)

E-mail:
service.detect@leuze.de
 
Repair service and returns:
Procedure and Internet form can be found at
www.leuze.com/repair
Return address for repairs:
Service center
Leuze electronic GmbH + Co. KG
In der Braike 1
D-73277 Owen / Germany
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16 Technical data

16.1 General specifications

Table 16.1:  Optical data

Table 16.2:  Measurement field data: Operating range limit and measurement field length of the 
CML 720i Ex

Table 16.3:  CML 720i Ex operating ranges

Table 16.4: CML 720i Ex profile and measurement field lengths

Light source LED (modulated light)

Wavelength 940 nm (infrared light)

Beam spacing [mm] Typ. op. range limit a) [m] Measurement field length b) [mm]

Min. Max. Min. Max.

5 0.1 4.5 150 2950

10 0.2 9.0 140 2860

20 0.2 9.0 130 2850

40 0.2 9.0 250 2810

a) Typ. operating range limit: min./max. attainable range without function reserve for parallel-beam scanning.

b) Measurement field lengths and beam spacings specified in fixed rasters, see ordering table.

Beam spacing [mm] Operating range [m]
Parallel-beam

Operating range [m]
Diagonal-beam

Operating range [m]
Crossed-beam

Min. Max. Min. Max. Min. Max.

5 0.1 3.5 0.2 2.6 0.2 2.2

10 0.3 7.0 0.3 5.2 0.3 4.4

20 0.3 7.0 0.5 5.2 0.5 4.4

40 0.3 7.0 1.0 5.2 1.0 4.4

Measurement field 
length B [mm]

Measurement field 
length B [mm]

Measurement field 
length B [mm]

Measurement field 
length B [mm]

Profile length L 
[mm]

with beam spacing A 
5 mm

with beam spacing A
10 mm

with beam spacing A 
20 mm

with beam spacing A
40 mm

150 140 130 - 168

230 - - - 248

310 300 290 250 328

390 - - - 408

470 460 450 - 488

550 - - - 568
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630 620 610 570 648

710 - - - 728

790 780 770 808

870 - - - 888

950 940 930 890 968

1030 - - - 1048

1110 1100 1090 - 1128

1190 - - - 1208

1270 1260 1250 1210 1288

1350 - - - 1368

1430 1420 1410 - 1448

1510 - - - 1528

1590 1580 1570 1530 1608

1670 - - - 1688

1750 1740 1730 - 1768

1830 - - - 1848

1910 1900 1890 1850 1928

1990 - - - 2008

2070 2060 2050 - 2088

2150 - - - 2168

2230 2220 2210 2170 2248

2310 - - - 2328

2390 2380 2370 - 2408

2470 - - - 2488

2550 2540 2530 2490 2568

2630 - - - 2648

2710 2700 2690 - 2728

2790 - - - 2808

2870 2860 2850 2810 2888

2950 - - - 2968

Measurement field 
length B [mm]

Measurement field 
length B [mm]

Measurement field 
length B [mm]

Measurement field 
length B [mm]

Profile length L 
[mm]

with beam spacing A 
5 mm

with beam spacing A
10 mm

with beam spacing A 
20 mm

with beam spacing A
40 mm
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Table 16.5:  Data on the time behavior of the CML 720i Ex

Table 16.6: Electrical data

Table 16.7: CML 720i Ex open-circuit current

Table 16.8: CML 720i Ex measurement field length and explosion protection

Table 16.9:  Interface data

Response time per beam a) 30 µs

Readiness delay ≤  1.5 s

a) Cycle time = number of beams x 0.03 ms + 0.4 ms. The minimum cycle time is 1 ms.

Operating voltage UB 18 … 30 VDC (incl. residual ripple)

Residual ripple ≤  15 % within the limits of UB

Measurement field length 
[mm]

Current consumption [mA] (without load at switching output)

at UB 24 VDC at UB 18 VDC at UB 30 VDC

150 135 165 125 

310 165 200 145 

630 215 275 190

950 270 345 235

1430 350 455 300

1910 435 650 365

2870 600 780 500

Measurement field length
(see table 16.4)

Explosion protection

130 mm to 2550 mm Zone 2 (gas), zone 22 (dust)

2630 mm to 2950 mm Zone 22 (dust)

Inputs/outputs 2 pins can be configured as input or output

Switching output current Max. 100 mA

Signal voltage active/not active ≥  8 V / ≤  2 V

Activation delay ≤  1 ms

Input resistance Approx. 6 k Ω

Digital interfaces IO-Link (230.4 kbit/s; 38.4 kbit/s)
CANopen (max. 1 Mbit/s)
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Table 16.10:  Mechanical data

Table 16.11:  Environmental data

Table 16.12:  Certifications

16.2 Time behavior
In principle, the individual beams are always processed sequentially for light curtains. The internal 
controller starts transmitter 1 and then activates only the corresponding receiver 1 to measure the received 
light power. If the measured value exceeds the switch-on threshold, this first beam is evaluated as an unin-
terrupted/free beam. 
The time between activation of the transmitter and evaluation in the receiver is referred to as the response 
time per beam.
 
In the CML 720i Ex the response time per beam is = 30 µs.

Housing Continuous-cast aluminum

Optics cover PMMA plastic

Connection technology M12 connectors
(8-pin / 5-pin)

Ambient temperature (operation) -30 °C … +60 °C

Ambient temperature (storage) -40 °C … +70 °C

Protective circuit Transient protection
Polarity reversal protection
Short circuit protection for all outputs (provide external 
protective circuit for inductive load for this purpose!)

Degree of protection IP 54

Protection class III

Certifications UL 508, CSA C22.2 No.14
Light source: exempt group (in acc. with EN 62471)

Ex certification (explosion protection) II 3G Ex nA op is IIB T4 Gc X
II 3D Ex tc IIIB T85°C Dc IP54 X

Standards applied IEC 60947-5-2

Electromagnetic compatibility IEC 61000-6-2 and EN 1000-6-4
Industrial interference emission
This is a Class A product. In a domestic environment, this 
product may cause radio interference. In this case the 
operator may be required to take appropriate measures.

The minimum cycle time is 1 ms, i.e., the cycle time is never less than 1 ms, even with very short                    
light curtains with a small number of beams.
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Table 16.13: Profile and measurement field lengths, cycle times for the CML 720i Ex

Measurement 
field length B 
[mm]

Measurement 
field length B 
[mm]

Measurement 
field length B 
[mm]

Measurement 
field length B 
[mm]

Profile length 
L [mm]

with beam spac-
ing A 
5 mm

Cycle time 
[ms]

with beam spac-
ing A ]
10 mm

Cycle time 
[ms]

with beam spac-
ing A 
20 mm

Cycle time 
[ms]

with beam spac-
ing A
40 mm

Cycle time 
[ms]

150 1.36 140 1.00 130 1.00 - - 168

230 1.84 - - - - - - 248

310 2.32 300 1.36 290 1.00 250 1.00 328

390 2.8 - - - - - - 408

470 3.28 460 1.84 450 1.12 - - 488

550 3.76 - - - - - - 568

630 4.24 620 2.32 610 1.36 570 1.00 648

710 4.72 - - - - - - 728

790 5.2 780 2.8 770 ?? 808

870 5.68 - - - - - - 888

950 6.16 940 3.28 930 1.84 890 1.12 968

1030 6.64 - - - - - - 1048

1110 7.12 1100 3.76 1090 2.08 - - 1128

1190 7.6 - - - - - - 1208

1270 8.08 1260 4.24 1250 2.23 1210 1.36 1288

1350 8.56 - - - - - - 1368

1430 9.04 1420 4.72 1410 2.56 - - 1448

1510 9.52 - - - - - - 1528

1590 10.0 1580 5.2 1570 2.8 1530 1.6 1608

1670 10.48 - - - - - - 1688

1750 10.96 1740 5.68 1730 3.04 - - 1768

1830 11.44 - - - - - - 1848

1910 11.92 1900 6.16 1890 3.28 1850 1.84 1928

1990 12.4 - - - - - - 2008

2070 12.88 2060 6.64 2050 3.52 - - 2088

2150 13.36 - - - - - - 2168

2230 13.84 2220 7.12 2210 3.76 2170 2.08 2248

2310 14.32 - - - - - - 2328

2390 14.8 2380 7.6 2370 4.0 - - 2408

2470 15.28 - - - - - - 2488

2550 15.76 2540 8.08 2530 4.24 2490 2.32 2568

2630 16.24 - - - - - - 2648

2710 16.72 2700 8.56 2690 4.48 - - 2728

2790 17.2 - - - - - - 2808

2870 17.68 2860 9.04 2850 4.72 2810 2.56 2888

2950 18.16 - - - - - - 2968
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Limits for detecting objects

The detection of objects and the evaluation of the data depend on the following factors:
• Beam resolution and cycle time of the light curtain
• Movement speed of the objects
• Transmission rate of the data bytes
• Cycle time of the control

Minimum object diameter for detection perpendicular to beam plane
For a moving object, the cycle time of the light curtain must be shorter than the period of time that the object 
to be detected is located in the beam plane.

For an object that moves vertically to the beam plane, the following apply:

vmax [m/s] = Maximum object speed
L [m] = Length of the object in the direction of movement
tz [s] = Cycle time of the light curtain

or

Lmin [m] = Length of the object in the direction of movement (minimum length)
v [m/s] = Object speed
tz [s] = Cycle time of the light curtain

16.3 Minimum object diameter for stationary objects
The minimum object diameter of a stationary object is determined by the beam spacing and optic diameter.
Minimum object diameter for “parallel” beam mode:
The minimum object diameter depends on the beam spacing because objects also need to be reliably 
detected in the transition area between two beams.

NOTICE
Minimum length of the gap between two successive objects!
 The gap between two successive objects must be greater than the minimum object diameter.

vmax L 10mm–  tz =

Lmin v tz 10mm+=

Beam spacing Minimum object diameter

5 mm Beam spacing + 5 mm = 10 mm

10 mm / 20 mm / 40 mm Beam spacing + 10 mm = 20 mm / 30 mm / 50 mm

NOTICE
Minimum object diameter for “crossed beam” mode!
 In “crossed beam” mode, the object diameter in the center area is reduced to 1/2 x beam spacing.
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16.4 Dimensioned drawings

all dimensions in mm
A Beam spacing (see chapter 16.1)
B Measurement field length (see table 16.4)
C Power In/Out + transmitter connection (Y-cable)
D Fieldbus connection (Y-cable for CANopen devices)
E Connection to receiver
F M6 thread
G Fastening groove
L Profile length (see table 16.4)
R Receiver
T Transmitter
W (see table 16.14)
X, Y (see table 16.14)

Figure 16.1: CML 720i Ex with axial connector outlet

Table 16.14:

Dimension
Beam spacing A [mm] 

(5) 10 20 (40)

X [mm] 15.5 23 23 43
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16.5 Dimensioned drawings: Accessories

all dimensions in mm
Figure 16.2: BT-2L mounting bracket

all dimensions in mm
Figure 16.3: BT-2Z parallel bracket

W [mm] 59 66.5 76.5 96.5

Y [mm] 2.5 5 5 5

The 5 mm and 40 mm beam spacings can only be ordered following consultation with Leuze.

Dimension
Beam spacing A [mm] 

(5) 10 20 (40)
39

16
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R10
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12
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6.
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R
3.

1

R
10 R
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10

R
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1
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all dimensions in mm
Figure 16.4: BT-2R1 swivel mount (shown in two mounting views)

all dimensions in mm
Figure 16.5: BT-2HF swivel mount
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all dimensions in mm
Figure 16.7: BT-2SB10/BT-2SB10-S swiveling mounting brackets

all dimensions in mm

Figure 16.6: BT-2SSD and BT-2SSD-270 swiveling mounting brackets
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all dimensions in mm
Figure 16.8: BT-2P40 clamp bracket
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17 Order guide and accessories

17.1 Nomenclature
Part designation:
CMLbbbi- fss-xxxx.a/ii-eee-ooo

Table 17.1: Part number code

Table 17.2: Part descriptions, examples

CML Operating principle: measuring light curtain

bbbi Series: 720i for CML 720i
Series: 730i for CML 730i**
Series: 730 for CML 730-PS**

f Function classes:
T: Transmitter
R: Receiver

ss Beam spacing:
05: 5 mm*

10: 10 mm
20: 20 mm
40: 40 mm*

xxxx Measurement field length [mm], dependent on beam spacing:
Values, see tables

a Equipment:
A: Axial connector outlet
R: rear connector outlet*

ii Interface:
L: IO-Link
CN: CANopen
PB: PROFIBUS*

PN: PROFINET*

CV: Analog current and voltage output*
D3: RS 485 Modbus*

eee Electrical connection:
M12: M12 connector

ooo Option:
EX: Explosion protection
PS: Power Setting

*: This device model can only be ordered in the design with explosion protection upon consultation with 
Leuze.
**: Not available in the design with explosion protection.

Part designation Properties

CML720i-T10-1580.A/
CN-M12-EX

CML 720i, transmitter, beam spacing 10 mm, measurement field length 
1580 mm, axial connector outlet, CANopen interface, M12 connector, explosion 
protection (zones 2 + 22)

CML720i-T05-1920.A/
CN-M12

CML 720i, transmitter, beam spacing 5 mm, measurement field length 
1920 mm, axial connector outlet, CANopen interface, M12 connector

CML720i-T05-1920.A/
D3-M12

CML 720i, transmitter, beam spacing 5 mm, measurement field length 
1920 mm, axial connector outlet, RS 485 Modbus interface, M12 connector
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17.2 Accessories – CML 720i Ex with CANopen or IO-Link interface

1 Y-interconnection cable (transmitter – receiver synchronization (X1/X3) + power), see table 17.3
2 Connection cable (PWR IN/Digital IO), see table 17.4
3 CANopen Y-interconnection cable X2 (BUS IN/BUS OUT), see table 17.5
4 CANopen terminating resistor, see table 17.6
5 CANopen interconnection cable, see table 17.7

Figure 17.1: CANopen/IO-Link interface

CML730i-T20-2720.A-
M12

CML 730i, transmitter, beam spacing 20 mm, measurement field length 
2720 mm, axial connector outlet, M12 connector

CML730i-R20-2720.R/
PB-M12

CML 730i, receiver, beam spacing 20 mm, measurement field length 2720 mm, 
rear connector outlet, PROFIBUS interface, M12 connector

CML730i-R20-2720.R/
D3-M12

CML 730i, transmitter, beam spacing 20 mm, measurement field length 
2720 mm, rear connector outlet, RS 485 Modbus interface, M12 connector

CML730-R05-1280.R/
CV-PS-M12-M12

CML 730-PS, receiver, beam spacing 5 mm, measurement field length 
1280 mm, rear connector outlet, analog interface, M12 connector

Part designation Properties

For devices with IO-Link interface, the X2 connection on the receiver is not assigned.

The Y-fieldbus cable (3) is not required.

1 1

2 235 3 4
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Table 17.3: X1/X3 cable accessories – CML 720i Ex with CANopen or IO-Link interface

Table 17.4: PWR IN/digital IO cable accessories – CML 720i Ex with CANopen or IO-Link interface

PWR IN/digital IO cable accessories: core colors
• Pin1 = brown
• Pin2 = white
• Pin3 = blue
• Pin4 = black
• Pin5 = gray

Part no. Part designation Description

X1/X3 Y-connection and synchronization cables for CML 700i (transmitter – receiver synchronization 
(X1/X3) + power); see figure 17.1

50118182 K-Y1 M12A-2m-M12A-S-PUR Y-interconnection cable: duo-socket M12 (receiver 
X3), 8-pin, A-coded; shielded PUR cable, length 
150 mm, M12 connector, 5-pin (power); shielded 
PUR cable, length 2,000 mm, M12 socket, 5-pin 
(transmitter)

50118183 K-Y1 M12A-5m-M12A-S-PUR Y-interconnection cable: duo-socket M12 (receiver 
X3), 8-pin, A-coded; shielded PUR cable, length 
150 mm, M12 connector, 5-pin (power); shielded 
PUR cable, length 5,000 mm, M12 socket, 5-pin 
(transmitter)

50122336 K-Y1 M12A-10m-M12A-S-PUR Y-interconnection cable: duo-socket M12 (receiver 
X3), 8-pin, A-coded; shielded PUR cable, length 
150 mm, M12 connector, 5-pin (power); shielded 
PUR cable, length 10,000 mm, M12 socket, 5-pin 
(transmitter)

50122337 K-Y1 M12A-20m-M12A-S-PUR Y-interconnection cable: duo-socket M12 (receiver 
X3), 8-pin, A-coded; shielded PUR cable, length 
150 mm, M12 connector, 5-pin (power); shielded 
PUR cable, length 20,000 mm, M12 socket, 5-pin 
(transmitter)

Part no. Part designation Description

X1 short open end of the Y-interconnection cable for CML 700i (PWR IN/digital IO); see figure 17.1

50132077 KD U-M12-5A-V1-020 Connection cable: M12 socket, 5-pin, A-coded; 
PVC cable, length 2 m, open cable end

678055  CB-M12-5000E-5GF Connection cable, length 5 m, shielded, PUR 
sheathing

678056  CB-M12-10000E-5GF Connection cable, length 10 m, shielded, PUR 
sheathing

678057  CB-M12-15000E-5GF Connection cable, length 15 m, shielded, PUR 
sheathing

678058  CB-M12-25000E-5GF Connection cable, length 25 m, shielded, PUR 
sheathing

The specified core colors apply only if the cables from Leuze are used.
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Table 17.5: X2 cable accessories – CML 720i Ex with CANopen or IO-Link interface

Table 17.6: Termination/bus termination accessories – CML 720i Ex with CANopen or IO-Link 
interface

Table 17.7: Cable accessories – CML 720i Ex with CANopen or IO-Link interface

Part no. Part designation Description

X2 Y-interconnection cables CANopen for CML 700i (BUS IN, BUS OUT); see figure 17.1

50118185 K-YCN M12A-M12A-S-PUR Y-interconnection cable CANopen: duo-socket 
M12, 5-pin, A-coded (receiver X2); shielded PUR 
cable, length 250 mm to M12 connector, 5-pin 
(BUS IN); shielded PUR cable, length 350 mm, 
M12 socket, 5-pin (BUS OUT)

50118184 K-YCN M12A-5m-M12A-S-PUR Y-interconnection cable CANopen: duo-socket 
M12, 5-pin, A-coded (receiver X2); shielded PUR 
cable, length 250 mm to M12 connector, 5-pin 
(BUS IN); shielded PUR cable, length 5,000 mm, 
M12 socket, 5-pin (BUS OUT)

Part no. Part designation Description

Termination/bus termination for CML 700i (terminating resistor); see figure 17.1

50040099 TS 01-5-SA Terminating connector for CANopen interface 
(BUS OUT), with integrated terminating resistor

Part no. Part designation Description

Interconnection cables CANopen for CML 700i; see figure 17.1

50129779 KDS DN-M12-5A-M12-5A-P3-
010

Interconnection cable, M12 connector/socket, 
axial, 5-pin, A-coded, length 1,000 mm, shielded, 
PUR

50129780 KDS DN-M12-5A-M12-5A-P3-
020

Interconnection cable, M12 connector/socket, 
axial, 5-pin, A-coded, length 2,000 mm, shielded, 
PUR

50129781 KDS DN-M12-5A-M12-5A-P3-
050

Interconnection cable, M12 connector/socket, 
axial, 5-pin, A-coded, length 5,000 mm, shielded, 
PUR

50129782 KDS DN-M12-5A-M12-5A-P3-
100

Interconnection cable, M12 connector/socket, 
axial, 5-pin, A-coded, length 10,000 mm, shielded, 
PUR

50129783 KDS DN-M12-5A-M12-5A-P3-
200

Interconnection cable, M12 connector/socket, 
axial, 5-pin, A-coded, length 20,000 mm, shielded, 
PUR
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17.3 Accessories – fastening technology 

Table 17.8: Mounting technology accessories 

Table 17.9: Interlocking guard 

Part no. Part designation Description

Mounting technology

429056 BT-2L L mounting bracket (angled), 2 x

429057 BT-2Z Z mounting bracket (parallel), 2 x

429046 BT-2R1 360° swivel mount, 2 x incl. 1 MLC cylinder

429058 BT-2SSD Swiveling mounting bracket with vibration damper, 
8°, 70 mm long, 2x

429059 BT-4SSD Swiveling mounting bracket with vibration damper, 
8°, 70 mm long, 4x

429049 BT-2SSD-270 Swiveling mounting bracket with vibration damper, 
8°, 270 mm long, 2x

424422 BT-2SB10 Swiveling mounting bracket, 8°, 2x

424423 BT-2SB10-S Swiveling mounting bracket with vibration damper, 
8°, 2x

429393 BT-2HF 360° swivel mount, 2 x incl. 1 CML cylinder

429394 BT-2HF-S 360° swivel mount, 2 x, with vibration damper, incl. 
1 CML cylinder

424417 BT-2P40 Mounting set, consisting of 2 BT-P40 clamp brack-
ets for mounting in UDC-S2-R device columns

425740 BT-10NC60 Sliding block with M6 thread, 10 x

425741 BT-10NC64 Sliding block with M6 and M4 thread, 10 x

425742 BT-10NC65 Sliding block with M6 and M5 thread, 10 x

Part no. Part designation Description

Interlocking guard

50109217 K-VM12-Ex Mechanical interlocking guard for M12 connection, 
5 x
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17.4 Accessories – PC connection

Table 17.10: Accessories - PC connection configuration

17.5 Accessories – protective film

Table 17.11: Protective film 

Part no. Part designation Description

IO-Link USB master V2.0

50121098 SET MD12-US2-
IL1.1 + accessories

IO-Link USB master V2.0
Plug-in power supply unit (24 V/24 W) with inter-
national adapters
High-speed USB 2.0 connection cable; USB A to 
Mini-USB
Data carrier with software, drivers and documenta-
tion

Adapter cables for CML 700i (IO-Link, analog)

50120999 K-DS M12A-8P-4P-2m L-PUR Adapter cable: M12 socket, 8-pin, B-coded; PUR 
cable, length 2,000 mm; M12 connector, 5-pin,  
B-coded

50121000 K-DS M12A-8P-4P-5m L-PUR Adapter cable: M12 socket, 8-pin, B-coded; PUR 
cable, length 5,000 mm; M12 connector, 5-pin,  
B-coded

Part no. Part designation Description

50143913 PT 20-CL3500 Protective film, roll, 20 mm wide, 350 m long
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17.6 Accessories - Device columns
For devices with axial connector outlet only

Table 17.12: Accessories - Device columns

17.7 Scope of delivery
• 1 transmitter incl. 2 sliding blocks (profile length from 2 m: 3 sliding blocks; profile length from 2.5 m: 

4 sliding blocks)
• 1 receiver incl. 2 sliding blocks, (profile length from 2 m: 3 sliding blocks; profile length from 2.5 m:  

4 sliding blocks)
• 1 set of operating instructions (PDF file on data carrier)

Part no. Part designation Description

549881 UDC-1000-S2-R Device column, U-shaped, profile height 1000 mm

549882 UDC-1300-S2-R Device column, U-shaped, profile height 1300 mm

549883 UDC-1600-S2-R Device column, U-shaped, profile height 1600 mm

549884 UDC-1900-S2-R Device column, U-shaped, profile height 1900 mm

549885 UDC-2500-S2-R Device column, U-shaped, profile height 2500 mm

549886 UDC-3100-S2-R Device column, U-shaped, profile height 3100 mm

Connection and interconnection cables, mounting brackets, IO-Link USB master (incl.         
Sensor Studio configuration software), etc., are not included in the delivery contents but must             
rather be ordered separately.

Devices with rear connector outlet are also delivered with a cylinder and a screw. These extra               
parts are needed for mounting with the BT-2R1 swivel mount (see table 17.8).
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18 EC Declaration of Conformity
The measuring light curtains of the CML series have been developed and manufactured in accordance 
with the applicable European standards and directives.
The manufacturer of the product, Leuze electronic GmbH + Co. KG in D-73277 Owen, possesses a certi-
fied quality assurance system in accordance with ISO 9001.
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